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1 Introduction 

 

1.1 The Rostrotentorial Approach in Veterinary Medicine 

 

With advanced diagnostic imaging getting more precise and readily available, our possibilities 
of diagnosing intracranial masses in their early stages rise dramatically. This is especially 
important as “Intracranial neoplasia is frequently encountered in dogs.” (Song et al. 2013) and 
“Intracranial neoplasia represent a major cause of morbidity and mortality.” (Dickinson 2014) 
It is suggested that certain brachycephalic breeds, namely Boxers, Boston Terriers and 
Bulldogs are especially prone to astrocytomas and oligodendrogliomas. (Dickinson 2014) 

In dogs, five standard approaches, namely the lateral rostrotentorial, the bilateral 
rostrotentorial, the suboccipital caudotentorial, the ventral and the transfrontal approach were 
developed (Oliver et al. 1987, Oliver JE Jr 1966, 1968). The possibility of combining these 
approaches is used to expose most areas of the brain. (Pluhar et al. 1996) 

The rostrotentorial approach is a surgical opening of the calvarium mainly in the area of the os 
parietale but also the os frontale and os temporale can be involved. The purpose of this surgery 
is the exposition and removal of pathologies in this region, originating from the soft tissue, 
nervous tissue, or bone. It provides ready access for fragment removal, fracture repair, 
intracranial decompression, intracranial abscessation, or masses. (Kramer et al. 2007) The 
research and advancement in this area is becoming more important as intracranial surgery in 
dogs is becoming more commonplace, especially for resection of brain tumours or to obtain 
biopsies for a definitive histopathologic diagnosis. (Dickinson 2014, Pluhar et al. 1996) A 
definitive diagnosis of intracranial pathologies is only possible by histopathologic examination 
oftentimes followed by additional tests of the affected tissue. Acquisition of pathologic tissue 
requires either specialized biopsy instruments or an already highly invasive surgery. Most 
neuro-oncological studies in veterinary medicine are limited by a lack of histopathologic 
evaluation and a small number of cases.  (Dickinson 2014) In human medicine molecular 
genetic analysis of tumors has become commonplace for grading besides histopathologic 
examinations. (Dickinson 2014, Park et al. 2017) Removal of intracranial masses is very 
challenging, but should be manageable with a standard operating procedure which also 
includes a histological diagnosis, staging and 3D imaging prior to surgery. (Boston 2010) 
Previous studies indicate a comparatively positive outcome after removal surgery of 
rostrotentorial masses with mean survival times longer than for infratentorial neoplasms. 
(Dickinson 2014, Suñol et al. 2017) However, it is important to mention that the outcome of 
surgery is highly dependent on the equipment, the expertise and knowledge of the surgeon. 
(Dickinson 2014, Steyrer 2018) 

For a craniotomy, the osseous part of the calvarium will be preserved and later re-established, 
contrary to the craniectomy where part of the calvarium is removed and cranioplasty will be 
performed afterwards. Craniectomy usually is performed for tumors which affect the bones of 
the calvarium, like primary bone tumors or soft tissue neoplasia that invades the osseous 
structures. (Boston 2010) Cranioplasty can be performed to recover and replace bones that 
had to be altered or removed due to any pathologies, but is not thought to be necessary in 
dogs if the temporalis muscle can be used to cover the defect. (Boston 2010) 
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Craniotomy approaches in animals are often derived from its human counterparts, albeit with 
modifications as a result of the anatomic differences such as the larger cranial muscles. (Pluhar 
et al. 1996) 

The rostrotentorial approach has been used in dogs as well as in cats, calves and horses. 
(Braun et al. 1977, Goulle et al. 2011, Janicek et al. 2006, Kramer et al. 2007, Wouters et al. 
2011) 

Dewey et al. (2007) evaluated cases with a combined rostrotentorial and suboccipital 
craniotomy with the rostral border being 1-2cm caudal of the sutura coronalis. The only 
intraoperative complication was a haemorrhage from the sinus transversus in one of the dogs. 
They suggest this was due to them choosing to create a larger window for better 
decompression. A smaller window would decrease the risk of sinus transversus haemorrhage, 
but if a haemorrhage occurs, the possibility of intervention might not be sufficient enough. 

There is a number of different variations surgeons have used and published.  
Bilderback and Faissler (2009) performed a modified rostrotentorial craniectomy on a defect 
centred on the os parietale. 32 months after surgery the dog was still doing well with occasional 
seizure activity which was treated with Levetiracetam. 

Suñol et al. (2017) did a retrospective study of 29 cases with intracranial masses in a 
rostrotentorial location. Three different approaches were performed including transfrontal in 20 
dogs, frontoparietal in five dogs and parietotemporal in four dogs. The median survival time for 
dogs with meningiomas was 422 days, for dogs with gliomas 66 days. Although they state that 
the secondary changes evaluated on MRI like the presence of a midline shift and ventricular 
compression have a significant impact on the survival time, their study showed a longer 
survival time than previously reported. 

Past studies only vaguely described the surgical part of the craniotomies or craniectomies they 
performed and did not exactly specify how the procedure took place. Only recently a study on 
the rostrotentorial approach was carried out (Steyrer 2018), which  described every step and  
evaluated its  procedure on safety and reproducibility in mesaticephalic dogs. The drill holes 
for mesaticephalic dogs were determined on a virtual skull for gaining the biggest possible 
rostrotentorial approach without damaging vital structures. The percentage of the exposed 
brain surface and of the different gyri  was calculated. The gyrus ectosylvius medius was the 
most exposted gyrus in the rostrotentorial approach (99.92%). The venous or pneumatised 
sinus systems were not damaged. (Steyrer 2018)  

Aim of this diploma thesis is to create a reproducible rostrotentorial approach in brachycephalic 
dogs. By determining bony landmarks on virtual skulls, the rostrotentorial approach will be 
evaluated for consistency and safety.   

The drill points determined for brachycephalic dogs are compared with the drill entry points in 
mesaticephalic dogs evaluated in a diploma thesis. (Steyrer 2018) 
The hypothesis is that the specific drill holes for brachycephalic dogs are not applicable for 
mesaticephalic dogs or vice versa.  
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1.2 Anatomy 

 

1.2.1 The Skull 

The skeleton of the skull is divided into the bones of the cranium, which surrounds the brain, 
and the bones of the face. In this chapter, we only focus on the anatomy of the cranium 
because of its relevance for the rostrotentorial approach.  

The cavum cranii consists of following bones: os frontale, os parietale, os interparietale, os 
occipitale, os temporale, os praesphenoidale, os ethmoidale, os basisphenoidale. (Figure 1 
and Figure 2) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1: Bones of the skull, lateral aspect. (Hermanson et al. 
2020) 

Figure 2: Bones of the skull, medial aspect of sagittal section. (Hermanson et al. 2020) 
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The cavum cranii has one big opening rostrally which is called the lamina cribrosa and another 
one caudally, which is called the foramen magnum. The lamina cribrosa connects the cavum 
cranii with the cavum nasii and contains the fibres of the nervus olfactorius. (Figure 2) The 
foramen magnum on the other hand is the opening where the systema nervosum centrale 
leaves the skull as medulla oblongata and then continues as medulla spinalis into the canalis 
vertebralis.  

 

1.2.1.1 The Sinus Paranasales 

The sinus paranasales are air cavities inside the skull bones and are covered in mucosa. 
These cavities all are connected to the cavum nasi, and therefore connected to the outer 
environment. In dogs, we differentiate the recessus maxillaris and the sinus frontalis. The most 
important sinus for this study is the sinus frontalis and it lies within the os frontale. It is 
separated into three compartments, namely the rostral, medial, and lateral sinus frontalis with 
the latter being the biggest. It is important to mention that the sinus frontalis is the cavity with 
the biggest variations in the skull and brachycephalic dogs often are reported to have a small 
or absent sinus frontalis. (Figure 3) (Evans and Miller 1979, Hermanson et al. 2020) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3: Paranasal sinuses in three types of skulls (Hermanson et al. 2020) 



5 

 

The sinus frontalis is important for the rostrotentorial approach, as an unintentional trephination 
can cause major complications such as pneumocephalus – also known as pneumatocele or 
intracranial aerocele –, which is caused by air breaking into the cavum epidurale, cavum 
subdurale or cavum subarachnoidale. (M Das and Bajaj 2020) This condition can develop 
when the cranium is connected to the external environment and the pressure gradient favours 
an inflow of air. (Cavanaugh et al. 2008) 

 

1.2.2 Morphometric Analysis of the Canine Skull 

“Skulls differ more in size and shape among domestic dogs than in any other mammalian 
species.” (Hermanson et al. 2020) The different breeds vary so much in size and proportion, 
for example, toy breeds compared to Great Danes, that it could appear they are different 
genera, but domesticated dogs clearly are members of the same species. (Wayne 1986) 

Bony landmarks to take measurements and to classify different skulls have been described 
before. (Onar 1999, Stockard et al. 1941)  (Figure 4, Figure 5, Figure 6) 

Inion: Central surface point on the protuberantia occipitalis externa.  

Bregma: Junction on the median plane of the right and left sutura coronalis, or the point of the 
crossing of the sutura coronalis and sutura sagittalis.  

Nasion: Junction on the median plane of the right and left sutura frontonasalis.  

Prosthion: Rostral end of the sutura interincisiva, located between the roots of the dorsal 
central dentes incisivi.  

Basion: Middle of the ventral margin of the foramen magnum.  

Centre of the meatus acusticus externus: Although unnamed, this spot also serves as a 
reference point. 

These terms (Inion, Bregma, Nasion, Prosthion and Basion) are not referenced in the Nomina 
Anatomica Veterinaria, but they have obtained popularity among clinicians.  (Hermanson et al. 
2020)  
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Figure 4: Skull, lateral view showing craniometric points. (Hermanson et al. 2020) 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: Skull, dorsal view showing 

craniometric points. (Hermanson et al. 2020) 

Figure 6: Skull, ventral view showing  
craniometric points (Hermanson et al. 2020) 
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Table 1 shows average measurements of the three different skull types, namely 
brachycephalic, mesaticephalic and dolichocephalic. The measurements were taken from 
randomly selected dogs. The skull measurements vary vastly between these three types, 
especially in the facial measures. (Hermanson et al. 2020) 

Table 1: Average measurements of three skull types. (Hermanson et al. 2020) 

 

 

For differentiation of the skull types, the Cephalic index and Cranial index are used. The 
Cephalic index puts the facial width and skull length in relation whereas the Cranial index does 
the same with the cranial width and the cranial length. We distinguish between brachycephalic, 
mesaticephalic and dolichocephalic skulls.  

The bones of the skull which build the facial area is called the viscerocranium and show the 
greatest variation in between the breeds. Dolichocephalic breeds show a smaller width of the 
rostrum as well as the arcus zygomaticus, whereas brachycephalic breeds show a greater 
width than mesaticephalic dogs. Dolichocephalic dogs also have an elongated rostrum and 
brachycephalics a shorter one. (Schoenebeck and Ostrander 2013) 
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Figure 7: Differences between skull types (modified from Schoenebeck and Ostrander (2013)) 

ros=rostrum, za=zygomatic arch, nc=neurocranium 

 

A short nose, which may appear as it were pushed-in, relatively big orbits and brachygnathia 
inferior are typical for brachycephalic breeds, such as bulldogs and pugs. The term 
“brachycephalic” originates from human medicine and means “short head”. (Schoenebeck and 
Ostrander 2013) Cavum cranii of brachycephalic breeds often resembles those of human 
hydrocephalus. The most extreme resemblance is found in Chihuahuas, whose American 
Kennel Club breed standard describes the desirable skull as having an “apple dome” and also 
normalizes open fontanelles which are based on a non-closure of the cranial sutures. 
(Schoenebeck and Ostrander 2013) Brachycephalia in dogs can be accompanied by a variety 
of craniofacial anomalies such as a reduction in the length of bones that form the rostrum, 
chondrodysplasia of the basis cranii interna, and changes in the position of the palatum durum 
relative to the basis cranii interna. (Schoenebeck and Ostrander 2013) Skeletal growth in 
brachycephalic dogs is known to be decreased due to hormonal deficits or epiphyseal 
dysfunction of long bones and the spine, however brain growth does not seem to be affected 
as much. (Schmidt et al. 2014) A defective growth reaction of the basicranial physeal cartilages 
results in the typical brachycephalic skull shape and is driven by a deficiency in the 
cartilaginous matrix which grows to become the os basioccipitale and the os basisphenoidale. 
(Stockard et al. 1941) A disproportion of the basis cranii interna compared to the overall body 
size (Lüps 1973, Stockard et al. 1941) suggests, that the regulation of growth at the 
synchondroses plays a role in the origin of brachycephalic and dolichocephalic skull shapes. 
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(Schoenebeck and Ostrander 2013) Studies suggest a strong correlation between brain and 
skull volumes and bodyweight as brachycephalic dogs have a significantly larger total brain 
volume relative to bodyweight compared to mesaticephalic breeds. Factoring in the usually 
overall smaller body size compared to the other two types, brachycephalic dogs also have less 
space in their skull that is not occupied by the brain. (Schmidt et al. 2014) The brain growth in 
brachycephalic breeds follows a lateral expansion which also becomes visible by the relatively 
large facial width. This is due to the fact that the neurocranial growth in brachycephalic dogs 
is limited in its anterior-posterior dimension. (Schmidt et al. 2009) 

 

1.2.3 The Encephalon 

The systema nervosum centrale consists of the encephalon and the medulla spinalis and both 
are made of the substantia grisea and the substantia alba. The substantia grisea mostly 
includes perikaryons from the neurons and forms the cortex and the nuclei in the encephalon. 
The substantia alba contains mostly myelinated axons and together with the substantia grisea 
forms the formatio reticularis and the truncus encephali. Furthermore, the encephalon can be 
divided into three parts: the cerebrum, the cerebellum and the truncus encephali. (Hermanson 
et al. 2020) 

1.2.3.1 The Cerebrum 

The cerebrum, being the biggest of the three parts, is built by the two hemispheria cerebri and 
the fissura longitudinalis which separates these. The two hemispheria cerebri are only 
connected via the corpus callosum, the fornix, the hippocampus and the commissura rostralis. 

The 

cortex cerebri is made of three layers, namely the archicortex (means old cortex), paleocortex 
(means very old cortex) and the biggest of the three, the neocortex (new cortex). (Hermanson 
et al. 2020) The following Figure 9 and Figure 10 were provided by Ao.Univ.-Prof. Dr.med.vet. 
Sabine Breit of the VUW and show the correct nomenclature for the gyri and sulci which build 
the surface of the hemispheria cerebri.  

Figure 8: Compared portrayal of the brain location in a German Shepherd (dolichocephalic breed) 
and a French Bulldog (brachycephalic breed). (Nickel et al. 2004) 

1 processus zygomaticus ossis frontalis; 2 crista sagittalis externa; 2’ planum parietale; 3 
protuberantia occipitalis externa; 4 crista nuchae; 5 crista supramastoidea (6) meatus acusticus 
externus; 7 fossa mandibularis of the articulatio temporomandibularis; 8 arcus zygomaticus; 9 



10 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 10: Nomenclature of the gyri and sulci (dorsal view) (Breit Sabine) 

 

Figure 9: Nomenclature of the gyri and sulci (lateral view) (Breit Sabine) 
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The anatomic literature does not completely agree with the exact nomenclature of the gyri and 
sulci, so the one taught at the VUW is used in this study. In the following Table 2 and Table 3 
the different naming schemes of certain structures are represented. 

Table 2: Gyri with different naming 

Gyri with different naming 
gyrus suprasylvius rostralis gyrus coronalis gyrus ectomarginalis rostralis (NAV) 
gyrus suprasylvius medius gyrus ectomarginalis, pars lateralis (NAV) 
gyrus suprasylvius caudalis gyrus ectomarginalis caudalis (NAV) 

The following Table 3 shows the terms for the gyri and sulci used in this thesis. 

Table 3: List of Gyri and Sulci 

Gyrus Sulcus 
gyrus sylvius rostralis fissura pseudosylvia 
gyrus sylvius caudalis sulcus ectosylvius caudalis 
gyrus ectosylvius rostralis sulcus ectosylvius rostralis 
gyrus ectosylvius medius sulcus ectosylvius medius 
gyrus ectosylvius caudalis sulcus suprasylvius caudalis 
gyrus suprasylvius rostralis sulcus suprasylvius medius 
gyrus suprasylvius medius sulcus ectomarginalis 
gyrus suprasylvius caudalis sulcus coronalis 
gyrus ectomarginalis sulcus ansatus 
gyrus occipitalis sulcus praesylvius 
gyrus marginalis sulcus proreus 
gyrus endomarginalis sulcus ansatus 
gyrus postcruciatus sulcus cruciatus 
gyrus praecruciatus sulcus marginalis 
gyrus proreus sulcus endomarginalis 

 

1.2.3.2 The Truncus Encephali 

The truncus encephali lies in between the rostral cerebrum and the caudal medulla spinalis. 
Apart from the nervus olfactorius, all nervi craniales originate from the truncus encephali. The 
diencephalon builds the rostral segment which links to the cerebrum. The mesencephalon 
builds the middle section and also contains the aqueductus mesencephali. The caudal part of 
the truncus encephali is named the medulla oblongata which connects to the medulla spinalis 
directly. The rostral and ventral part of the medulla oblongata is called the pons. (Hermanson 
et al. 2020) 

1.2.3.2.1 The Mesencephalon 

The mesencephalon consists of three segments which are called the tegmentum, substantia 
nigra and the crus cerebri. The nervus oculomotorius and the nervus trochlearis derive  from 
this part of the encephalon. The aqueductus mesencephali, which lies in the middle of the 
mesencephalon, forms the connection of the ventriculus quartus and the ventriculus tertius of 
the diencephalon. (Hermanson et al. 2020) 
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1.2.3.2.2 The Diencephalon 

This rostral section of the truncus encephali is built by the thalamus, metathalamus, 
hypothalamus, epithalamus and the subthalamus. It holds the ventriculus tertius and has 
bilateral connections to the hemispheria cerebri. (Hermanson et al. 2020) 

1.2.3.3 The Cerebellum 

The cerebellum is the major coordinator of the body movements as well as the ability to assess 
distances which is an important function for precise moves. Just like the cerebrum it has two 
hemispheria cerebelli and a vermis which lies in the median. The surface has many ridges and 
grooves, which are not specified any further. The fissura uvulonodularis splits the cerebellum 
into the corpus cerebelli and the lobus flocculonodularis. (Hermanson et al. 2020) 

1.2.4 The Cerebral Lobes 

The hemispheria cerebri can be divided into five cerebral lobes each. The most rostral is called 
the cortex frontalis, caudal and dorsal to that lies the lobus parietalis. The cortex occipitalis is 
the most caudal part, and the lateral lobe is called the cortex temporalis. (Figure 11) The 
phylogenetically oldest and most ventral lobe is called the lobus piriformis. (Hermanson et al. 
2020) Because of the high anatomic variability, the differentiation of the lobes is rather vague 
but some structures to separate them are agreed on. (Uemura 2015) 

 

Figure 11: Cerebral lobes (Copyright 2010 by Saunders, an imprint of Elsevier Inc.) 
https://slideplayer.com/slide/8421143/ (accessed May 18, 2020) 

(1) cortex frontalis, (2) cortex parietalis, (3) cortex occipitalis, (4) cortex temporalis, (5) lobus piriformis including 
bulbus olfactorius 
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1.2.5 The Meninges 

The systema nervosum centrale is covered in different layers of meninges with spaces in 
between. For this study, we only describe the meninges of the brain. The meninges are called 
the dura mater encephali, the arachnoidea encephali and the pia mater encephali. 

1.2.5.1 The Dura mater encephali 

The dura mater encephali is composed mainly of collagen bundles, fibroblasts, elastic fibres, 
vessels, and sensory nerves. “It lines the cranial cavity, simultaneously covering the brain and 
serving as periosteum for the cranial cavity.” (Hermanson et al. 2020) The dura mater 
originates embryologically as a double layer and where these layers separate, a venous sinus 
is generally present. The falx cerebri is its biggest partition and separates both cerebral 
hemispheres from each other. Caudally the dura mater encephali builds the tentorium cerebelli 
membranaceum which extends over the tentorium cerebelli osseum and separates the 
cerebral hemispheres from the cerebellum. The third partition is the diaphragma sellae and 
separates the hypophysis from the truncus encephali. 

1.2.5.2 The Arachnoidea Encephali 

The arachnoidea encephali is composed by flattened fibroblasts and collagen fibres. It adheres 
to the inner surface of the dura mater encephali and only separates from it in case of a 
pathologic condition. Furthermore, it is connected to the pia mater via trabeculae but also 
separated from it by the cavum subarachnoidale.  

1.2.5.3 The Cavum Subarachnoidale 

The cavum subarachnoidale is filled with liquor cerebrospinalis and big vessels. It has four 
bigger enlargements called cisternae subarachnoidales which are called the cisterna 
cerebellomedullaris, cisterna valleculae lateralis cerebri, cisterna chiasmatis and cisterna 
interpeduncularis. The cisterna cerebellomedullaris is commonly known for the ability to obtain 
liquor cerebrospinalis and is located where the caudal surface of the cerebellum meets the 
dorsal surface of the medulla oblongata. 

1.2.5.4 The Pia Mater Encephali 

The pia mater follows every irregularity of the brain surface and is very vascular because all 
vessels entering and leaving the systema nervosum centrale must travel in pia mater.  

1.2.6 The Sinus Durae Matris 

As mentioned before, the dura mater encephali has two layers in between which the sinus 
durae matris is found. These sinuses appear in certain large osseous canals. The sinuses 
differentiate from the regular venous system in its consistent lumen, the lack of valves, the 
tunica media and tunica adventitia.  

We differentiate the dorsal and the ventral sinuses which freely intercommunicate. (Figure 12) 
The dorsal sinus consists of the unpaired sinus sagittalis dorsalis, sinus rectus and the paired 
sinus transversus, sinus petrosus dorsalis, sinus temporalis and sinus sigmoideus.  
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Figure 12: Sinus durae matris, simplified, medial aspect (Salomon et al. 2020) 

(1) sinus sagittalis dorsalis, (2) vv. Cerebri dorsales, (3) v. diploica frontalis, (4) v. diploica parietalis, (5) sinus 
rectus, (6) sinus transversus, (7) sinus cavernosus, (8) sinus petrosus ventralis, (9) sinus basilaris, (10) sinus 

interbasilaris, (11) sinus temporalis 

 

1.2.6.1 The Dorsal Sinus 

The sinus sagittalis dorsalis begins rostrally, takes the right and left veins that come from the 
nasal cavity and then runs caudally inside a channel of the falx cerebri close to the crista 
sagittalis interna and the sutura sagittalis. It collects the vv. cerebri dorsales as well as most 
of the vv. diploicae and joins the sinus rectus at its end. (Hermanson et al. 2020) 

The sinus rectus begins at the caudal end of the falx cerebri where the v. cerebri magna and 
the v. corporis callosi join together and then runs through the caudal part of the falx cerebri. 
There the right and left parts of the tentorium cerebelli membranaceum join it and the sinus 
rectus lies rostrodorsal to the tentorium cerebelli osseum. (Hermanson et al. 2020)  

The part where the sinus sagittalis dorsalis merges with both sinus transversus and usually 
the sinus rectus, is called confluens sinuum and is located within the dorsal part of the os 
occiptale.  

Starting at the confluens sinuum, the sinus transversus runs laterally in the canalis sinus 
transversi and then continues in the sulcus sinus transversi for its last third. At the end it divides 
into the sinus temporalis and the sinus sigmoideus. 

The sinus sigmoideus is an S-shaped continuation from the sinus transversus and merges with 
the sinus petrosus ventralis. It bends ventromedially and caudally before it enters the foramen 
jugulare, the sinus basilaris divides from it and runs in the canalis condylaris and then 
continues as plexus venosus vertebralis internus. (Hermanson et al. 2020) 

The sinus temporalis is a continuation of the sinus transversus and runs in the rostral direction 
inside the meatus temporalis. (Hermanson et al. 2020) 

The sinus petrosus dorsalis builds a connection between the rostral end of the sinus sagittalis 
dorsalis and the sinus transversus close to the ventral end of the sulcus sinus transversi. 
(Hermanson et al. 2020)  
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1.2.6.2 The Ventral Sinus 

The ventral sinus consists of the paired sinus cavernosus, sinus basilaris, sinus condylaris, 
sinus petrosus ventralis and the unpaired sinus intercavernosus rostralis and caudalis. (Figure 
13) 

The sinus cavernosus is paired and is the major drainage for the ventral parts of the brain. 
Each sinus starts rostrally at the fissura orbitalis, where they also intercommunicate through 
the plexus ophtalmicus, then runs on the floor of the fossa cranii media to the canalis 
petrooccipitalis. There it continues as the sinus petrosus ventralis and is connected to the 
plexus venosus vertebralis internus. Medially the two sinus cavernosus are connected through 
the two sinus intercavernosus, one being rostrally and one caudally to the stalk of the dorsum 
sellae.  (Hermanson et al. 2020) 

 

 

Figure 13: Cranial venous sinuses, dorsal aspect (calvaria removed.) (Reinhard et al. 1962) 

 

The following chapters will guide the reader through the process of visualisation and simulation 
of the craniotomies as well as the subsequent measurements and calculations which were 
performed. 
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2 Material and Methods 

 

2.1 Diagnostic Imaging 

The CT and MRI images were provided by the Clinical Unit of Diagnostic Imaging at the VUW 
and then reviewed for usability in this study. The database search included all brachycephalic 
dogs which had a CT and an MRI scan of the head in the time between 1.1.2014 and 
13.12.2018 as well as every mesaticephalic dog which had a CT and an MRI scan of the head 
between 1.1.2010 and 11.03.2019. 

Inclusion criteria were completeness of the scans and lack of pathologic conditions affecting 
the systema nervosum centrale as well as the osseous part of the cranium. The remaining 
scans included four French bulldogs, one Golden Retriever and three mesaticephalic 
crossbreeds. (Table 4) 

Table 4: Information about the dogs 

Information about dogs from whom the databases were used  
Dog Number Breed Sex Age Weight in kg 
Dog1 Golden Retriever female spayed 7a 8m 36 
Dog2 Mix female spayed 14a 6m 23.7 
Dog3 Mix female spayed 6a 6m n.a 
Dog4 Mix male spayed 16a 2m 5.4 
Dog5 French Bulldog female spayed 13a 7m 9.3 
Dog6 French Bulldog male 7a 1m 11.6 
Dog7 French Bulldog male spayed 11a 9m 17 
Dog8 French Bulldog male 9a 5m 19.6 
Dogs 1-4 are in the mesaticephalic group, dog 5-8 in the brachycephalic group. a = years, 
m= months, n.a. = not available 

 

2.2 Visualization 

The chosen scans were loaded onto the University server for further processing of the images.  
The workstation was situated at the VetCORE facility for Research of VUW and the programme 
Amira 2019.01 (Thermo Fischer Scientific) was used for the 3D visualization of the provided 
scans. A standard operating procedure will be attached to this thesis for further traceability and 
reproducibility. (Appendix pages) Nonetheless, I will explain the basic process here.  

First the CT scans, saved as DICOM files, were loaded into Amira, and then saved as Amira 
files. Each patient had its own project folder to avoid any possibility of confusion. A basic 3D 
model of the skull was created by using the “Isosurface” tool with a threshold of 350 
Houndsfield Units. This 3D model then was aligned on a global axis after setting 34 landmarks 
in a specific order.  
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Table 5 contains these points of interest. The points we chose are a modified version of the 
publication of Drake and Klingenberg, 2010. 

 

Table 5: Landmarks used to align the skulls 

Number Designation 
1 Bregma 
2 Inion 
3 midpoint of Bregma and Inion 
4 processus nasalis sinister 
5 processus nasalis dexter 
6 sutura internasalis, most rostral point 
7 Nasion 
8 processus frontalis ossis zygomaticus sinister 
9 processus zygomaticus ossis frontalis sinister 
10 canalis opticus sinister, medioventrally 
11 meatus acusticus externus sinister, craniolaterally 
12 dens caninus sinister (204), posterior buccal corner 
13 dens praemolaris 3 sinister (207), posterior buccal corner  
14 dens praemolaris 4 sinister (208), posterior buccal corner 
15 processus frontalis ossis zygomaticus dexter 
16 processus zygomaticus ossis frontalis dexter 
17 canalis opticus dexter, medioventrally 
18 meatus acusticus externus dexter, craniolaterally 
19 dens caninus dexter (104), posterior buccal corner 
20 dens praemolaris 3 dexter (107), posterior buccal corner 
21 dens praemolaris 4 sinister (108) 
22 processus mastoideus sinister 
23 processus mastoideus dexter 
24 processus paracondylaris sinister 
25 processus paracondylaris dexter 
26 tuberculum nuchale sinsiter 
27 tuberculum nuchale dexter 
28 condylus occipitalis sinister 
29 condylus occipitalis dexter 
30 Basion 
31 os palatinum, most caudal point 
32 hamulus pterigoidei sinister 
33 hamulus pterigoidei dexter 
34 Prosthion 
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2.3 Morphometric Analysis 

After the alignment of the 3D model on the global axis, the different types of skull shapes are 
differentiated by using the morphometric analysis including the cranial and cephalic index. Its 
goal is to quantify the huge variability of the skull in dogs.  

The cranial measurements are taken by setting the render mode to “orthographic”, using the 
“Scalebar” tool and then zooming in and out until the scalebar fits the landmarks.  
Table 6 contains the cranial measurements which were used in this study and the Figure 14 
and Figure 15 show the measurements in the dorsal and the lateral view, illustrated by Onar 
(1999). The Figure 15 has been been modified to resemble the measurements in dorsal view 
as they were taken in this study. 

 

Table 6: Measurements for the cranial index 

Measurements Landmarks Info 
Facial length Nasion to Prosthion  dorsal view 
Facial width widest interzygomatic distance  dorsal view 
Cranial length Inion to Nasion  dorsal view 
Cranial width widest interparietal distance  dorsal view 
Cranial height middle of Meatus acusticus externus to bregma lateral view 
Skull length Inion to Prosthion  dorsal view 
Skull base length Basion to Prosthion  ventral view 

 

 

Figure 14: Measurements of the cranium (dorsal view) (Onar 1999) 
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(I) Inion, (N) Nasion, (P) Prosthion, (E) Euryon, (Z) Zygion, (1) skull length, (2) cranial length, (3) viscerocranial 
length, (4) maximum width of neurocranium, (5) maximum zygomatic width 

 

 

 

 

 

 

 

 

 

These cranial measurements were then used to calculate the Cranial and the Cephalic index. 

 

𝐶𝑟𝑎𝑛𝑖𝑎𝑙 𝑖𝑛𝑑𝑒𝑥 =
𝑐𝑟𝑎𝑛𝑖𝑎𝑙 𝑤𝑖𝑑𝑡ℎ ∗ 100

𝑐𝑟𝑎𝑛𝑖𝑎𝑙 𝑙𝑒𝑛𝑔𝑡ℎ
 

 

𝐶𝑒𝑝ℎ𝑎𝑙𝑖𝑐 𝑖𝑛𝑑𝑒𝑥 =  
𝑓𝑎𝑐𝑖𝑎𝑙 𝑤𝑖𝑑𝑡ℎ ∗ 100

𝑠𝑘𝑢𝑙𝑙 𝑙𝑒𝑛𝑔𝑡ℎ
 

 

To further differentiate between mesaticephalic and brachycephalic, the median of the 
Cephalic index (CI) of all dogs will be calculated and used as breakpoint. The Dogs were split 
at the median of the CI and the skulls below the median are classified as “Low CI” representing 
the mesaticephalic group and dogs with a CI higher than the median are classified as “High 
CI” and represent the brachycephalic group. (Roberts et al. 2010) 

To further evaluate this method, a t-test for sample pairs was performed between both groups 
to provide information about its significance. 

Afterwards the MRI files, saved as DICOM files, are loaded into Amira, roughly aligned to the 
CT images and then with help of the “Register Images” tool properly aligned. After everything 
was aligned perfectly, the brain was cropped out of the MRI images and the resolution 
increased drastically. Then a surface of the resampled brain was created in order to be able 
to do measurements. This freshly created surface was used to identify the cortex and the gyri.  

Figure 15: Modified measurements of the cranium (lateral view) (Onar 1999) 

(I) Inion, (P) Prosthion, (N) nasion, (1) skull length, (2) viscerocranial length and (3) cranial length  
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Table 7 contains every surface which was measured for this thesis and Figure 16 is used to 
illustrate them. 

Table 7: Gyri used in this study 

Number Surface name 
1 cortex 
2 gyrus sylvius rostralis 
3 gyrus sylvius caudalis 
4 gyrus ectosylvius rostralis 
5 gyrus ectosylvius medius 
6 gyrus ectosylvius caudalis 
7 gyrus suprasylvius rostralis  
8 gyrus suprasylvius medius 
9 gyrus ectomarginalis 
10 gyrus suprasylvius caudalis 
11 gyrus occipitalis 
12 gyrus marginalis 
13 gyrus endomarginalis 
14 gyrus postcruciatus 
15 gyrus praecruciatus 
16 gyrus proreus 

 

 

 

 

 

 

 

 

 

 

Figure 16: Brain with all Gyri drawn in 

(1) cortex (2) gyrus sylvius rostralis (3) gyrus sylvius caudalis (4) gyrus ectosylvius rostralis (5) gyrus ectosylvius 
medius (6) gyrus ectosylvius caudalis (7) gyrus suprasylvius rostralis (8) gyrus suprasylvius medius (9) gyrus 
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ectomarginalis (10) gyrus suprasylvius caudalis (11) gyrus occipitalis (12) gyrus marginalis (13) gyrus 
endomarginalis (14) gyrus postcruciatus (15) gyrus praecruciatus (16) gyrus proreus 

2.4 The Rostrotentorial Approach 

The rostrotentorial approach in mesaticephalic dogs has been evaluated in a diploma thesis 
at the VUW. (Steyrer 2018)  

For ease of use, the described approach in Steyrer (2018) will be called “Approach 
Mesaticephalic” and the one developed in this thesis will be called “Approach Brachycephalic”. 
Mesaticephalic dogs will be named Dog 1 to 4 and the brachycephalic dogs will be named Dog 
5 to 8 in the following chapters.  

First, the approach and landmarks of the „Approach Brachycephalic“ are described. 
Landmarks for the drilling points were based on palpable osseous structures and imaginary 
lines between those. 

 

2.4.1 Drill Holes „Approach Brachycephalic“ (Figure 21) 

For the first drill hole, draw an imaginary line between the Processus zygomaticus ossis 
frontalis and the ipsilateral Crista supramastoidea. In order to allow a safety margin to stay 
clear of the Sinus frontalis, you must measure 10mm in the caudal direction on this line, starting 
at the Processus zygomaticus ossis frontalis.  

For the second drill hole, draw an imaginary line between the Processus zygomaticus ossis 
frontalis and the caudal end of the Crista supramastoidea. The drill hole will be in the exact 
middle of this line and is later used as a reference point for drill hole four. 

For the third drill hole, start by measuring the length of the Crista supramastoidea. Then, 
beginning at the base of the Arcus zygomaticus, go straight dorsally for just this length.  

Drill hole four lies exactly dorsally of drill hole two. Draw an imaginary line straight up from drill 
hole two to the midline of the skull. On this line, measure 20mm away from the midline in order 
to provide a safety margin. The reason why this safety margin is so big, once again is the 
variable shape of brachycephalic skulls. This drill hole will be used as a reference point for drill 
hole five. 

For the fifth and last drill hole, draw an imaginary line between drill hole four and the most 
caudal point of the Protuberantia occipitalis. This drill hole will be on the exact middle of this 
line. Variable skull shapes prohibit the declaration of a simple safety margin from the most 
caudal point in brachycephalic dogs. 
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Figure 18 illustrates the guiding lines used for the “Approach Brachycephalic” in mm. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 18: „Approach Brachycephalic“ on a brachycephalic dog – Drill holes 1 to 5 with guiding lines in mm 

Figure 17: „Approach Brachycephalic“ on a brachycephalic dog – Drill holes 1 to 5 

(1) drill hole 1 (2) drill hole 2 (3) drill hole 3 (4) drill hole 4 (5) drill hole 5 
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After setting the landmarks for the drill holes, the craniotomy area was drawn onto the skull, 
measured, and then deleted to show the underlying brain and the accessible gyri. The now 
accessible area of the brain and its Gyri were measured as well and then used for various 
calculations. 

2.4.2 Crista Sagittalis Externa 

To evaluate the safety of the approaches regarding laceration of the dorsal sinus system and 
the sinus sagittalis dorsalis, measurements from the most dorsal and therefore closest point 
of the craniotomy to the crista sagittalis externa have been done. These were done in Amira 
with help of the “measurement” tool. (Figure 20) 

 

Figure 20: Measuring the distance of the craniotomy area to the crista sagittalis externa (in mm) 

Figure 19: Comparison „Approach Mesaticephalic“ and “Approach Brachycephalic” on a 
mesaticephalic dog 

Blue: „Approach Brachycephalic“; Red: „Approach Mesaticephalic“ at the end of both approaches 
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2.4.3 Sinus Frontalis 

After simulating the craniotomy, the skulls were scanned for the existence of the Sinus frontalis. 
Furthermore, it was important to find out if the Sinus frontales were opened using the 
craniotomy approaches. This was done in Amira by creating an Ortho Slice tool of the CT scan 
and moving it one slice rostral to the craniotomy. (Figure 21) 

 

 

 

 

 

 

Figure 21: Ortho Slice tool set one slice rostrally to the craniotomy 

The frontal sinus was evaluated in the transverse view for any damages caused by the 
simulated drill holes. (Figure 22) Once the Ortho slice tool was in position, the 3D visualisation 
was used to to check the Sinus frontales for trepanation by the craniotomy. 

 

 

 

 

 

 

Figure 22: CT scan one slice rostral of the simulated craniotomy – the Sinus frontalis in this dog is cranial to the 
craniotomy and therefore unopened. 

 

2.4.4 Drill Holes “Approach Mesaticephalic” 

“Find the impression, indicated in red, between the sutura parietofrontalis and the temporal 
line, that indicates the border of the frontal sinuses. One centimetre laterally of the sagittal 
crest and 0.5 centimetres caudoventrally of this line (toward the centre of the neurocranium) 
The first hole is drilled as seen in Figure 23.” (Steyrer 2018) 
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,  

Figure 23: Location of the first hole (Steyrer 2018) 

 

“For the second hole (Figure 24) draw an imaginary line (straight red line) connecting the most 
lateral aspect of the zygomatic process of the frontal bone to the most caudal point of the 
occipital protuberance. Drill the second hole directly on this line, 0.5 centimetres caudally to 
the point where the impression described for hole number one (curved red line) intersects with 
it.” (Steyrer 2018) 

 

 

Figure 24: Location of the second hole (Steyrer 2018) 

 

“To locate the drilling site for hole number three (Figure 25) draw an imaginary line (straight 
red line) connecting the most lateral aspect of the zygomatic process of the frontal bone to the 
point where the nuchal crest meets the supramastoid crest. Drill the third hole exactly at the 
midpoint of this line.” (Steyrer 2018) 



26 

 

 

Figure 25: Location of the third hole (Steyrer 2018) 

“For hole number four measure the length of the supramastoid crest and project it from the 
base of the zygomatic process dorsally, parallel to the nuchal crest to locate the fourth drilling 
site as depicted in Figure 26.” (Steyrer 2018) 

 

 

Figure 26: Location of the fourth hole (Steyrer 2018) 

“For the last hole (Figure 27) draw an imaginary line (straight red line) connecting the most 
lateral aspect of the zygomatic process of the frontal bone to the most caudal point of the 
occipital protuberance. Find the impression at the base of the nuchal crest/external sagittal 
crest (curved red line). Drill the fifth hole directly on the connection line, 0.5 centimetres 
cranially from where the line intersects with the indentation.” (Steyrer 2018) 
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Figure 27: Location of the fifth hole (Steyrer 2018) 

 

2.4.5 Calculations and Statistics 

- Morphometric Analysis 
The measurements of the different lengths and widths necessary for the morphometric 
analysis (Table 6) were performed in Amira and then the Cranial and Cephalic index 
were calculated with the following formulas:  
 

𝐶𝑟𝑎𝑛𝑖𝑎𝑙 𝑖𝑛𝑑𝑒𝑥 =
𝑐𝑟𝑎𝑛𝑖𝑎𝑙 𝑤𝑖𝑑𝑡ℎ ∗ 100

𝑐𝑟𝑎𝑛𝑖𝑎𝑙 𝑙𝑒𝑛𝑔𝑡ℎ
 

 

𝐶𝑒𝑝ℎ𝑎𝑙𝑖𝑐 𝑖𝑛𝑑𝑒𝑥 =  
𝑓𝑎𝑐𝑖𝑎𝑙 𝑤𝑖𝑑𝑡ℎ ∗ 100

𝑠𝑘𝑢𝑙𝑙 𝑙𝑒𝑛𝑔𝑡ℎ
 

 
The Median of the Cephalic index then was calculated in Microsoft Excel with the 
function “MEDIAN()”. The results were evaluated by performing a t-test for independent 
samples with a significance level of  0.95. This means that a p ≤ 0.05 is a statistically 
significant result. 
 

- Craniotomy area on the skull in sqmm 
The craniotomy area has been extracted from Amira (paragraph 10.15 of the SOP on 
page 142). 
Then the mean value was calculated in Microsoft Excel with the function 
“MITTELWERT()” and the standard deviation with “STABW.N()”. These calculations 
were performed from the whole population (n=8) and both CI groups, respectively. 
 

𝑀𝑖𝑡𝑡𝑒𝑙𝑤𝑒𝑟𝑡 �̅� =
𝑎1 + 𝑎2 + ⋯ + 𝑎n

𝑛
 

 

𝑆𝑡𝑎𝑛𝑑𝑎𝑟𝑑𝑎𝑏𝑤𝑒𝑖𝑐ℎ𝑢𝑛𝑔 𝑠x =  √
1

𝑁 − 1
∗ ∑(𝜒𝑖 −  𝜒)2

𝑁

𝑖−1
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- Comparison of the craniotomy areas of both approaches 
The size comparison for one was portrayed by showing them next to each other for 
each dog but also by dividing the area of the “Approach Mesaticephalic” through the 
“Approach Brachycephalic”. 
 

𝑠𝑖𝑧𝑒 𝑐𝑜𝑚𝑝𝑎𝑟𝑖𝑠𝑜𝑛 =  
𝑐𝑟𝑎𝑛𝑖𝑜𝑡𝑜𝑚𝑦 𝑎𝑟𝑒𝑎 "𝐴𝑝𝑝𝑟𝑜𝑎𝑐ℎ 𝑀𝑒𝑠𝑎𝑡𝑖𝑐𝑒𝑝ℎ𝑎𝑙𝑖𝑐"

𝑐𝑟𝑎𝑛𝑖𝑜𝑡𝑜𝑚𝑦 𝑎𝑟𝑒𝑎 "𝐴𝑝𝑝𝑟𝑜𝑎𝑐ℎ 𝐵𝑟𝑎𝑐ℎ𝑦𝑐𝑒𝑝ℎ𝑎𝑙𝑖𝑐"
 

 
To further validate the results, a t-test for independent samples with a significance level 
of  0.95 has been performed.  
 

- Measurements to the crista sagittalis externa 
These measurements were taken in Amira with the “measurement” tool and written 
down. 
 

- Access to gyri 
To calculate in how many % of the dogs each separate gyrus has been accessed, the 
number of times it was exposed x in each CI group was divided through the number of 
dogs in each group (n = 4) and then multiplied by 100. 
 

𝑔𝑦𝑟𝑢𝑠 𝑎𝑐𝑐𝑒𝑠𝑠𝑒𝑑 𝑖𝑛 % =  
𝑥 𝑡𝑖𝑚𝑒𝑠 𝑒𝑥𝑝𝑜𝑠𝑒𝑑 𝑔𝑦𝑟𝑢𝑠

𝑛 𝑑𝑜𝑔𝑠 𝑖𝑛 𝑒𝑎𝑐ℎ 𝐶𝐼 𝑔𝑟𝑜𝑢𝑝
∗ 100 

 
This calculation was performed for the mesaticephalic as well as the brachycephalic 
group. The significance of the results was validated with a chi-square test based on 
Pearson and an exact test based on Fisher. The chi-square test requires a minimum 
sample size of five, which is not provided in these calculations and  therefore, another 
test which does not require a minimum sample size was performed, which in this case 
was the exact test based on Fisher.  
 

- Accessible gyri area in sqmm 
The total and the exposed area of the individual gyri in each approach and dog and 
also the total area of accessible brain area were extracted from Amira. The mean area 
of each gyrus was calculated by adding up the area (an) in sqmm of all measurements 
and dividing them by the number n of measured gyri. 
 

𝑀𝑖𝑡𝑡𝑒𝑙𝑤𝑒𝑟𝑡 �̅� =
𝑎1 + 𝑎2 + ⋯ + 𝑎n

𝑛
 

 
To calculate the % how much each gyrus has been exposed with each approach, the 
mean accessible gyrus area for the individual gyrus in each CI group was divided 
through the mean total gyrus area of each CI group. 
 

𝑚𝑒𝑎𝑛 𝑎𝑐𝑐𝑒𝑠𝑠𝑖𝑏𝑙𝑒 𝑔𝑦𝑟𝑢𝑠 𝑎𝑟𝑒𝑎 𝑖𝑛 𝑠𝑞𝑚𝑚 =   
𝑚𝑒𝑎𝑛 𝑎𝑐𝑐𝑒𝑠𝑠𝑖𝑏𝑙𝑒 𝑔𝑦𝑟𝑢𝑠 𝑎𝑟𝑒𝑎 𝑖𝑛 𝑠𝑞𝑚𝑚 

𝑚𝑒𝑎𝑛 𝑡𝑜𝑡𝑎𝑙 𝑔𝑦𝑟𝑢𝑠 𝑎𝑟𝑒𝑎 𝑖𝑛 𝑠𝑞𝑚𝑚
 

 
- Craniotomy area in comparison with the brain area 

The craniotomy area was compared to the accessible brain area. A mean value and a 
standard deviation have been calculated of the whole population (n = 8) and both CI 
groups, respectively. Again, a t-test for independent samples with a significance level 
of 0.95 was performed.  
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3 Results 

 

3.1 Morphometric Analysis 

The skull measurements taken for this study show proportions as expected with the longer 
facial lengths in the “Low CI” group (mesaticephalic dogs) and wider facial width in the “High 
CI” group (brachycephalic). It also becomes apparent that the cranial width in both groups is 
relatively similar even though the facial measurements vary so widely.  

Table 8: Measurements of the skull in mm 

Measurements of the skull in mm 

Dog Facial 
length 

Facial 
width 

Cranial 
length 

Cranial 
width 

Cranial 
height 

Skull 
length 

Skull base 
 length 

Cranial 
Index 

Cephalic 
index 

Dog1 97.10 115.00 112.30 67.74 71.48 208.10 187.30 60.32 55.26 Low CI 
Dog2 91.40 102.40 115.00 60.75 59.24 205.60 181.50 52.83 49.81 Low CI 
Dog3 84.39 104.00 108.00 62.54 56.77 192.10 174.40 57.91 54.14 Low CI 
Dog4 49.36 77.45 73.58 48.91 46.04 123.80 109.70 66.47 62.56 Low CI 
Dog5 38.72 125.90 93.64 61.67 55.31 132.70 114.60 65.86 94.88 High CI 
Dog6 40.25 127.00 84.18 57.70 54.97 125.50 109.30 68.54 101.20 High CI 
Dog7 24.29 95.43 84.43 60.26 53.93 108.60 89.51 71.37 87.87 High CI 
Dog8 31.61 112.80 89.47 63.09 51.99 121.10 97.38 70.52 93.15 High CI 

The median CI for this thesis was 75.22 with a standard deviation in the whole population of 
21.35, in the “Low CI” group of 5.30 and in the “High CI” group of 5.49. 
The t-test for independent samples between low and high CI shows p = 0.006 for the facial 
length, p = 0.026 for the skull length, p = 0.019 for the skull base length, p = 0.02 for the cranial 
index and p < 0.001 for the CI itself. (Figure 28) 

 

Figure 28: Cephalic index for each dog and median 
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These results show that the separation between mesaticephalic and brachycephalic was 
performed correctly and the dogs represent each group appropriately. 

3.2 Craniotomy Area on the Skull 

The area listed is in square millimetres (sqmm) with a mean value of the craniotomy area for 
the „Approach Brachycephalic“ of all dogs of 1276.22 sqmm (SD +/- 394.95 sqmm).  
For mesaticephalic dogs the mean value was 1286.39 sqmm (SD +/- 519.65 sqmm) and for 
brachycephalic dogs 1266.06 sqmm (SD +/- 204.29 sqmm). (Figure 29) 

 

Figure 29: Craniotomy areas of „Approach Brachycephalic“ 

The mean value of all dogs for the „Approach Mesaticephalic“ of 1694.65 sqmm (SD +/- 370.38 
sqmm), the mean value of mesaticephalic dogs 1738.60 sqmm (SD +/- 485.79 sqmm) and of 
brachycephalic dogs 1650.71 sqmm (SD +/- 185.76 sqmm). The greatest but also the smallest 
area was present in mesaticephalic dogs. (Figure 30) 

 

Figure 30: Craniotomy areas of „Approach Mesaticephalic“ 
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As suggested by the previous diagrams, the craniotomy area of the „Approach Mesaticephalic“ 
thorughout both CI groups is approximately 1.33 times bigger than in the „Approach 
Brachycephalic“. In the „Approach Brachycephalic“ the measured area is 1.30 times bigger in 
mesaticephalic dogs compared to brachycephalic dogs. (Figure 31)  

 

Figure 31: Comparison of craniotomy areas for brachycephalic dogs 

The craniotomy area of the „Approach Mesaticephalic“ is 1.35 times bigger in mesaticephalic 
dogs than in brachycephalic dogs. (Figure 32) 

 

Figure 32: Comparison of craniotomy areas for mesaticephalic dogs 

The biggest difference between both approaches was in Dog 4 where the „Approach 
Mesaticephalic“ showed a 1.72 times bigger area than the „Approach Brachycephalic“. Dog 1 
showed the smallest difference with 1.17 times.  
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When comparing the craniotomy area of the two approaches, the t-test for sample pairs has a 
p < 0.001 for the craniotomy area on both sides. This means that the “Approach 
Mesaticephalic” is providing a significantly bigger craniotomy area than the “Approach 
Brachycephalic”. 

The Figure 34 and Figure 33 provide an overview of the location and size of both craniotomy 
approaches in one of the mesaticephalic dogs. It is clearly visible that the craniotomy area in 
the “Approach Mesaticephalic” is bigger. 

 

Figure 35 and Figure 36 compare both approaches in one of the brachycephalic dogs. Again 
the “Approach Mesaticephalic” shows a bigger craniotomy area. But also, its borders are 
coming dangerously close to the crista sagittalis externa which also poses some risks. 

The measurements to assess how close the craniotomy is to the crista sagittalis externa 
showed that the “Approach Brachycephalic” consistently provides a more reasonable safety 
margin so that the dorsal sinus system is not damaged. Although it is worth to mention that the 
planned safety margin from the drill hole 4 should be 20 mm but has been slightly less in all 
participants. The “Approach Mesaticephalic” is very close (< 1 cm) to the median of the skull 
and therefore very close to the dorsal sinus system in every single dog with the smallest margin 
being 3.63 mm and the biggest 9.63 mm. (Table 9) 

Figure 34: "Approach Brachycephalic" in Dog 3 
(mesaticephalic dog) 

Figure 33: "Approach Mesaticephalic" in Dog 3 
(mesaticephalic dog) 

Figure 35: "Approach Brachycephalic" in Dog 7 
(brachycephalic dog) 

Figure 36: "Approach Mesaticephalic" in Dog 7 
(brachycephalic dog) 
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Table 9: Measurements from the craniotomy to the crista sagittalis externa 

Measurements from the craniotomy to the crista sagittalis externa 

Dog 
Approach Brachycephalic Approach Mesaticephalic 

left right left right 
Dog 1 16.09 18.49 9.28 9.54 
Dog 2 16.87 16.99 3.63 5.50 
Dog 3 18.97 18.30 6.66 6.82 
Dog 4 19.47 19.32 9.63 9.07 
Dog 5 18.56 19.08 5.85 7.18 
Dog 6 18.48 18.85 8.77 9.04 
Dog 7 19.26 18.50 7.43 5.12 
Dog 8 19.42 18.66 8.03 9.12 

 

3.3 Accessible Gyri 

The following two tables show in how many dogs each specific gyrus could be accessed. It 
does not give any information of how much of the individual gyrus is visible.  

In brachycephalic dogs, the gyrus sylvius rostralis, gyrus ectosylvius rostralis, gyrus 
ectosylvius medius, gyrus ectosylvius caudalis, gyrus ectosylvius caudalis, gyrus suprasylvius 
medius, gyrus ectomarginalis and gyrus suprasylvius caudalis were exposed in all dogs and 
both approaches. Furthermore, the „Approach Mesaticephalic“ exposed the gyrus sylvius 
caudalis and the gyrus occipitalis in all brachycephalic dogs and the “Approach 
Brachycephalic” the gyrus suprasylvius rostralis. (Table 10) 

Table 10: Access to gyri in brachycephalic dogs 

Access to gyri in brachycephalic dogs 

gyrus Approach Brachycephalic Approach Mesaticephalic 
left right mean left right mean 

gyrus sylvius rostralis 100% 100% 100% 100% 100% 100% 
gyrus sylvius caudalis 100% 75% 88% 100% 100% 100% 
gyrus ectosylvius rostralis 100% 100% 100% 100% 100% 100% 
gyrus ectosylvius medius 100% 100% 100% 100% 100% 100% 
gyrus ectosylvius caudalis 100% 100% 100% 100% 100% 100% 
gyrus suprasylvius rostralis 100% 100% 100% 75% 75% 75% 
gyrus suprasylvius medius 100% 100% 100% 100% 100% 100% 
gyrus ectomarginalis 100% 100% 100% 100% 100% 100% 
gyrus suprasylvius caudalis 100% 100% 100% 100% 100% 100% 
gyrus occipitalis 50% 50% 50% 100% 100% 100% 
gyrus marginalis 0% 75% 38% 50% 50% 50% 
gyrus endomarginalis 0% 25% 13% 25% 75% 50% 
gyrus postcruciatus 75% 75% 75% 50% 50% 50% 
gyrus praecruciatus 25% 25% 25% 0% 0% 0% 
gyrus proreus 0% 0% 0% 0% 0% 0% 
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The “Approach Brachycephalic” failed to expose the left gyrus marginalis, left gyrus 
endomarginalis and both sides of the gyrus proreus altogether in brachycephalic dogs. The 
“Approach Mesaticephalic” did not expose the gyrus praecruciatus and the gyrus proreus at 
all. (Table 10) This shows that the “Approach Brachycephalic” is superior in exposing the 
rostral gyri, whereas the “Approach Mesaticephalic” is more likely to expose the caudal gyri. 

In mesaticephalic dogs, the gyrus sylvius rostralis, gyrus sylvius caudalis, gyrus ectosylvius 
rostralis, gyrus ectosylvius medius, gyrus ectosylvius caudalis, gyrus suprasylvius rostralis and 
Gyrus suprasylvius medius can be accessed in all dogs and with both approaches. 
Furthermore, the „Approach Mesaticephalic“ exposed the gyrus ectomarginalis, gyrus 
suprasylvius caudalis, gyrus marginalis and the gyrus postcruciatus in all mesaticephalic dogs. 
The gyrus marginalis can be visualized more often in the “Approach Mesaticephalic” than in 
the “Approach Brachycephalic” on the left side (p = 0.028; chi-square test). The Gyrus proreus 
is significantly better accessible in  the “Approach Brachycephalic” on both sides  
(p = 0.028; chi-square test). Both Gyri do not show a significance in the exact test according 
to Fisher (p = 0.143 respectively). (Table 11) 

Table 11: Access to gyri in mesaticephalic dogs 

Access to gyri in mesaticephalic dogs 

gyrus Approach Brachycephalic Approach Mesaticephalic 
left right mean left right mean 

gyrus sylvius rostralis 100% 100% 100% 100% 100% 100% 
gyrus sylvius caudalis 100% 100% 100% 100% 100% 100% 
gyrus ectosylvius rostralis 100% 100% 100% 100% 100% 100% 
gyrus ectosylvius medius 100% 100% 100% 100% 100% 100% 
gyrus ectosylvius caudalis 100% 100% 100% 100% 100% 100% 
gyrus suprasylvius rostralis 100% 100% 100% 100% 100% 100% 
gyrus suprasylvius medius 100% 100% 100% 100% 100% 100% 
gyrus ectomarginalis 75% 75% 75% 100% 100% 100% 
gyrus suprasylvius caudalis 75% 100% 88% 100% 100% 100% 
gyrus occipitalis 0% 0% 0% 75% 75% 75% 
gyrus marginalis 25% 50% 38% 100% 100% 100% 
gyrus endomarginalis 25% 0% 13% 75% 100% 88% 
gyrus postcruciatus 75% 75% 75% 100% 100% 100% 
gyrus praecruciatus 75% 75% 75% 25% 25% 25% 
gyrus proreus 75% 75% 75% 0% 25% 13% 

The „Approach Brachycephalic“ failed to access the gyrus occipitalis in mesaticephalic dogs 
completely. Again the “Approach Brachycephalic” is better used for the rostral gyri and the 
“Approach Mesaticephalic” for the caudal and dorsal gyri. 

The Figure 39 provides an approximate overview of the accessible gyri in brachycephalic dogs 
if the “Approach Brachycephalic” is performed. The craniotomy lies centrally on the lateral part 
of the cranium and exposes a big variety of gyri. 
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Figure 37: „Approach Brachycephalic“ on a brachycephalic skull (Dog 5) 

(1) gyrus sylvius rostralis (2) gyrus sylvius caudalis (3) gyrus ectosylvius rostralis (4) gyurs ectosylvius medius (5) 
gyrus ectosylvius caudalis (6) gyrus suprasylvius rostralis (7) gyrus suprasylvius medius (8) gyrus ectomarginalis 

(9) gyrus suprasylvius caudalis 

The “Approach Mesaticephalic” in brachycephalic dogs is portrayed in the Figure 40 to provide 
an overview. In this dog the gyrus occipitalis was exposed additionally to the ones from the 
“Approach Brachycephalic”. But with a bigger craniotomy comes the potential risk of exposing 
irrelevant or hazardous tissue like seen in Figure 40 where caudally to the brain only bony 
tissue is removed and structures like the dorsal sinus system are at risk. 

 

Figure 38: „Approach Mesaticephalic“ on a brachycephalic dog (Dog 5) 

(1) gyrus sylvius rostralis (2) gyrus sylvius caudalis (3) gyrus ectosylvius rostralis (4) gyurs ectosylvius medius (5) 
gyrus ectosylvius caudalis (6) gyrus suprasylvius rostralis (7) gyrus suprasylvius medius (8) gyrus ectomarginalis 

(9) gyrus suprasylvius caudalis (10) gyrus occipitalis 
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The „Approach Brachycephalic“ managed to expose 100% of the gyrus ectosylvius medius in 
all brachycephalic dogs and failed to access the gyrus proreus altogether. The “Approach 
Mesaticephalic) did not expose the gyrus praecruciatus and gyrus proreus. (Table 12)  
In the „Approach Mesaticephalic“ 100% of the gyrus ectosylvius medius and the gyrus 
suprasylvius medius were accessible in all mesaticephalic dogs, but the “Approach 
Brachycephalic missed the gyrus occipitalis completely. (Table 13) 

The exposed area of the gyrus suprasylvius caudalis and the gyrus endomarginalis show a big 
difference in the “Approach Brachycephalic” in between sides. The biggest differences (> 20%) 
between the left and right side are showing up in the gyrus ectosylvius caudalis, gyrus 
suprasylvius caudalis, gyrus marginalis and the gyrus endomarginalis. The gyrus occipitalis 
was not exposed in the “Approach Brachycephalic) at all. (Table 12) The “Approach 
Mesaticephalic” does not show differences as big as the other approach. (Table 13)  

The 111.43% access of the gyrus endomarginalis in the „Approach Brachycephalic“ in 
mesaticephalic dogs is due to a mathemetical calculation. The unfortunately only accessed 
area of the gyrus endomarginalis in the “Approach Brachycephalic” on the left side of 
mesaticephalic dogs (59.72 sqmm) is divided through the mean area of the left gyrus 
endomarginalis in mesaticephalic dogs (53.59 sqmm) and then multiplied by 100 to get the 
result in percent. (59.72/53.59*100 = 1.1143*100=111.43%). (Table 13) 
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Table 12: Mean accessible gyri area in brachycephalic dogs in sqmm and % 

Mean accessible gyri area in brachycephalic dogs in sqmm and % 

gyrus 
Approach Brachycephalic Approach Mesaticephalic 

left right mean left right mean 
sqmm % sqmm % sqmm % sqmm % sqmm % sqmm % 

gyrus sylvius rostralis 82.82 37.68 55.62 33.37 69.22 35.53 64.38 29.29 47.15 28.29 55.76 28.79 
gyrus sylvius caudalis 26.66 26.73 27.69 29.56 27.17 28.15 25.82 25.89 25.03 26.72 25.42 26.31 
gyrus ectosylvius rostralis 99.56 71.34 117.66 53.59 108.61 62.47 71.80 51.45 76.83 35.00 74.31 43.23 
gyrus ectosylvius medius 172.74 100.00 153.21 100.00 162.97 100.00 163.24 94.50 138.59 90.46 150.92 92.48 
gyrus ectosylvius caudalis 183.26 58.11 172.46 51.72 177.86 54.92 181.04 57.41 192.08 57.61 186.56 57.51 
gyrus suprasylvius rostralis 177.32 54.74 180.03 62.74 178.67 58.74 135.46 41.82 126.74 44.17 131.10 43.00 
gyrus suprasylvius medius 137.45 99.55 209.56 93.93 173.50 96.74 120.21 87.06 163.49 73.28 141.85 80.17 
gyrus ectomarginalis 77.60 29.71 95.77 37.02 86.69 33.37 198.81 76.13 196.25 75.86 197.53 76.00 
gyrus suprasylvius caudalis 193.13 64.95 202.70 63.34 197.91 64.15 215.86 72.59 241.65 75.51 228.75 74.05 
gyrus occipitalis 14.65 5.04 15.93 5.64 15.29 5.34 218.23 75.04 187.78 66.50 203.00 70.77 
gyrus marginalis 0.00 0.00 11.56 13.68 5.78 6.84 91.68 77.22 70.34 83.24 81.01 80.23 
gyrus endomarginalis 0.00 0.00 10.62 8.43 5.31 4.22 4.07 4.01 21.63 17.16 12.85 10.59 
gyrus postcruciatus 25.30 10.40 38.01 19.86 31.65 15.13 4.34 1.79 5.62 2.94 4.98 2.37 
gyrus praecruciatus 2.52 0.88 1.47 0.41 2.00 0.65 0.00 0.00 0.00 0.00 0.00 0.00 
gyrus proreus 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
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Table 13: Mean accessible gyri area in mesaticephalic dogs in sqmm and % 

Mean accessible gyri area in mesaticephalic dogs in sqmm and % 

gyrus 
Approach Brachycephalic Approach Mesaticephalic 

left right mean left right mean 
sqmm % sqmm % sqmm % sqmm % sqmm % sqmm % 

gyrus sylvius rostralis 113.02 77.73 94.01 69.34 103.51 73.54 109.73 75.47 86.41 63.73 98.07 69.60 
gyrus sylvius caudalis 58.14 46.35 64.30 42.12 61.22 44.24 53.28 42.48 73.08 47.86 63.18 45.17 
gyrus ectosylvius rostralis 127.55 98.34 151.49 98.18 139.52 98.26 125.40 96.68 141.95 92.00 133.68 94.34 
gyrus ectosylvius medius 120.48 95.50 121.97 99.66 121.22 97.58 126.15 100.00 122.39 100.00 124.27 100.00 
gyrus ectosylvius caudalis 99.53 66.78 52.49 43.24 76.01 55.01 109.03 73.16 69.98 57.64 89.51 65.40 
gyrus suprasylvius rostralis 221.86 91.38 176.28 85.98 199.07 88.68 182.34 75.10 166.24 81.08 174.29 78.09 
gyrus suprasylvius medius 80.77 52.08 100.17 57.72 90.47 54.90 155.08 100.00 173.55 100.00 164.32 100.00 
gyrus ectomarginalis 37.83 17.39 51.44 22.02 44.64 19.71 185.03 85.06 211.26 90.41 198.14 87.74 
gyrus suprasylvius caudalis 3.95 1.63 78.62 36.37 41.28 19.00 128.18 53.04 133.03 61.54 130.60 57.29 
gyrus occipitalis 0.00 0.00 0.00 0.00 0.00 0.00 64.76 43.17 68.17 45.01 66.47 44.09 
gyrus marginalis 25.49 50.59 13.08 27.88 19.29 39.24 37.00 73.42 41.46 88.42 39.23 80.92 
gyrus endomarginalis 59.72 111.43 0.00 0.00 29.86 55.72 46.89 87.49 34.33 71.24 40.61 79.37 
gyrus postcruciatus 152.93 71.59 152.77 74.02 152.85 72.81 124.39 58.23 129.18 62.59 126.78 60.41 
gyrus praecruciatus 110.68 64.23 83.85 62.56 97.26 63.40 1.78 1.03 23.21 17.32 12.50 9.18 
gyrus proreus 43.71 23.38 36.89 18.57 40.30 20.98 0.00 0.00 33.77 16.99 16.88 8.50 
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In brachycephalic dogs, both approaches provide comparatively similar access to the gyrus 
sylvius rostralis, gyrus sylvius caudalis, gyrus ectosylvius medius and the gyrus ectosylvius 
caudalis. The „Approach Brachycephalic“ exposes a greater area for the gyrus ectosylvius 
rostralis, gyrus suprasylvius rostralis, gyrus suprasylvius medius and the gyrus postcruciatus. 
The „Approach Mesaticephalic“ provides better access to the gyrus ectomarginalis, gyrus 
suprasylvius caudalis, gyrus occipitalis, gyrus marginalis and gyrus endomarginalis. (Figure 
39) 

 

Figure 39: Mean gyri area and their accessibility in brachycephalic dogs 

For brachycephalic dogs, the “Approach Brachycephalic” should be preferred for the gyrus 
ectosylvius rostralis, gyrus suprasylvius rostralis, gyrus suprasylvius medius and the gyrus 
postcruciatus whereas the „Approach Mesaticephalic“ is preferred for the gyrus ectomarginalis, 
gyrus suprasylvius caudalis, gyrus occipitalis, gyrus marginalis and gyrus endomarginalis. 
However, the pros and cons of a very dorsal approach need to be balanced as there is the pro 
of a bigger exposed area of certain gyri, but also the con of the risk of lacerating the dorsal 
sinus system. 

In mesaticephalic dogs, the accessibility of the gyrus sylvius rostralis, gyrus sylvius caudalis, 
gyrus ectosylvius rostralis and the gyrus ectosylvius medius are similar in both approaches. 
The „Approach Mesaticephalic“ exposes more of the gyrus suprasylvius medius, gyrus 
ectomarginalis, gyrus suprasylvius caudalis, gyrus occipitalis, gyrus marginalis and the gyrus 
endomarginalis. The „Approach Brachycephalic“ outweighs for access to the gyrus 
suprasylvius rostralis, gyrus postcruciatus, gyrus praecruciatus and the gyrus proreus. (Figure 
40) 
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Figure 40: Mean Gyri Area and their accessibility in mesaticephalic dogs 

This shows that the “Approach Mesaticephalic” should be preferred to expose the gyrus 
suprasylvius medius, gyrus ectomarginalis, gyrus suprasylvius caudalis, gyrus occipitalis, 
gyrus marginalis and the gyrus endomarginalis and the „Approach Brachycephalic“ preferred 
for access to the gyrus suprasylvius rostralis, gyrus postcruciatus, gyrus praecruciatus and the 
gyrus proreus in mesaticephalic dogs. 

 

 

3.4 Craniotomy Area in comparison with Brain Area 

The area of the bone removed, and the underlying brain were compared.  

In the „Approach Brachycephalic“, seven of eight dogs showed a greater brain area than 
craniotomy area. Same as in the „Approach Mesaticephalic“, Dog 1 showed a greater 
craniotomy area than brain area. The mean brain area was 1372.99 sqmm (SD +/- 339.84 
sqmm)  and the mean craniotomy area 1276.22 sqmm (SD +/- 394.95 sqmm). (Figure 41)  
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Figure 41: Craniotomy area compared to the accessible brain area in the „Approach Brachycephalic“ 

In seven of eight dogs, the brain area was bigger than the craniotomy area in the „Approach 
Mesaticephalic“. The mean brain area was 1749.71 sqmm (SD +/- 306.70 sqmm) and the 
mean craniotomy area 1694.65 sqmm (SD +/- 370.38 sqmm). (Figure 42) 

 

Figure 42: Craniotomy area compared to accessible brain area in the „Approach Mesaticephalic“ 

When the exposed brain area of the two approaches in all participants is compared, the t-test 
for sample pairs has a p < 0.001 for on the left side. The exposed brain area on the right side 
has a p = 0.003. This means that the “Approach Mesaticephalic” is providing a significantly 
bigger exposed brain area than the “Approach Brachycephalic” in all participants. 

In the „Approach Brachycephalic“ in mesaticephalic dogs, the mean brain area with 1321.87 
sqmm (SD +/- 410.39 sqmm) was greater than the mean craniotomy area with 1286.39 sqmm 
(SD +/- 519.65 sqmm). Again, only Dog 1 had a greater craniotomy area than brain area. 
(Figure 43) 
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Figure 43: Craniotomy Area compared to the accessible brain area in the „Approach Brachycephalic“ in 
mesaticephalic dogs 

 

For the „Approach Mesaticephalic“ in mesaticephalic dogs, the mean craniotomy area with a 
value of 1738.60 sqmm (SD +/- 465.79 sqmm) was greater than the mean brain area with a 
value of 1734.47 sqmm (SD +/- 394.34 sqmm), although only one of four dogs had a greater 
craniotomy area than brain area. (Figure 44) 

 

Figure 44: Craniotomy Area compared to the accessible brain area in the „Approach Mesaticephalic“ in 
mesaticephalic dogs 

 

The „Approach Brachycephalic“ in brachycephalic dogs exposed a greater brain area than 
craniotomy area in all four dogs as well. The mean brain area was 1424.10 sqmm (SD +/- 
239.45 sqmm) and the mean craniotomy area was 1266.06 sqmm (SD +/- 204.29 sqmm). This 
difference of almost 2 sqcm could result in a better practicability due to smaller approaches 
necessary for extracranial masses. (Figure 45) 
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Figure 45: Craniotomy area compared to the accessible brain area in the „Approach Brachycephalic“ on 
brachycephalic dogs 

 

In the „Approach Mesaticephalic“ in brachycephalic dogs, all four dogs showed a greater brain 
area than craniotomy area which also shows in the mean brain area of 1764.95 sqmm (SD +/- 
179.33 sqmm) being greater than the mean craniotomy area of 1650.71 sqmm (SD +/- 185.76 
sqmm). (Figure 46) 

 

Figure 46: Craniotomy area compared to the accessible brain area in the „Approach Mesaticephalic“ on 
brachycephalic dogs 

 

In mesaticephalic dogs, the „Approach Mesaticephalic“ exposed only 99.76% brain area of the 
craniotomy area and the „Approach Brachycephalic“ 102.76%. In brachycephalic dogs, both 
approaches granted access to more brain area than the craniotomy area with the „Approach 
Mesaticephalic“ exposing 106.92% and the „Approach Brachycephalic“ 112.48%.  
There is no statistical significance in the craniotomy area nor in the exposed brain area in a t-
test for independent samples. 
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3.5 Sinus frontalis 

All four mesaticephalic dogs and Dog 7 and Dog 8 from the brachycephalic dogs have got a 
sinus frontalis on both sides. The brachycephalic Dog 5 only has got a sinus frontalis on its 
right side. This agrees with the previous findings that the sinus frontalis is inconsistent in 
brachycephalic dogs.  

In none of the brachycephalic dogs sinus frontales were opened by the “Approach 
Brachycephalic”, but three out of four left sinus frontales and three out of four right sinus 
frontales of the mesaticephalic dogs. 

In this study the “Approach Mesaticephalic” opened two out of four left sinus frontales of 
mesaticephalic dogs, no right sinus frontales of mesaticephalic dogs and none of the 
brachycephalic dogs. 

This result suggests that both approaches are safe regarding trepanation of the sinus frontales 
for brachycephalic dogs and the “Approach Mesaticephalic” is safer in mesaticephalic dogs. 
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4 Discussion 

Craniotomies in veterinary medicine have become more important and more advanced over 
time. The fact that diagnostic imaging today is more precise and used more often for neurologic 
cases, leads to more pathologies being diagnosed and consequently also being treated. 
Craniotomies are not used only for removal of tissue, but also for intracranial decompression 
or to take samples for biopsies. (Dickinson 2014, Kramer et al. 2007, Marquez-Grados et al. 
2020, Pluhar et al. 1996, Sharkey et al. 2004) The goal of this diploma thesis is to ensure a 
safe and reproducible access to the lateral regions of the brain in brachycephalic dogs. To 
achieve this, the database of the VUW was searched for dogs which had CT and MRI scans 
of the skull done (n = 8) which then were merged for a simulation and visualisation of the newly 
amended rostrotentorial approach as well as the approach evaluated by Steyrer (2018). This 
was done in four brachycephalic and four mesaticephalic dogs to then compare both 
approaches in the different skull types. The results of this study show that the “Approach 
Brachycephalic” is a safe way to access a number of gyri in brachycephalic dogs without 
damaging the sinus frontales or the dorsal sinus system. The “Approach Mesaticephalic” on 
the other hand results in an unfeasible and hazardous craniotomy because of its very dorsal 
location and the thereby arising complications. 

When loading the MRI scans into Amira, it is important to decide which sequence shows the 
best quality. (Steyrer 2018) used the T2-weighted sequence in his study but I considered the 
T1 to be the better option for my study. Moreover, the quality of MRI scans seemed to differ 
greatly between the dogs which resulted in variable outcome of generated brain surfaces as 
well as in the possibility to differentiate the gyri. This problem appeared especially in 
brachycephalic dogs as their brain is smaller in absolute numbers than the brain of 
mesaticephalic dogs. The varying quality of the scans may have a negative effect on how 
accurate each gyrus is definable and could therefore lead to an inaccurately measured area 
of the gyri. 

There is a big variety and inconsistency regarding Cranial and Cephalic Index in the different 
studies. The approach of Roberts et al. (2010) represents the differentiation between 
mesaticephalic and brachycephalic in this thesis best, because the standard deviation of the 
CI within each group is low, but higher throughout the whole population and the p < 0.001. 
Nevertheless, it must be pointed out that their approach depends on each individual study as 
the breakpoint is calculated from its own population and does not provide an absolute number 
to separate mesaticephalic from brachycephalic dogs. This means that this approach can 
theoretically calculate a “High CI” group, which indicates brachycephalic, in a homogenous 
mesaticephalic group. 

The craniotomy area on the skull in sqmm throughout both CI groups was 1.33 times bigger in 
the „Approach Mesaticephalic“ compared to the „Approach Brachycephalic“ and also is 
significant with a p < 0.001. Mesaticephalic dogs showed the biggest difference within the 
group and included the smallest and biggest overall area in the whole population of both 
approaches. This is represented by the relatively high standard deviation in the mesaticephalic 
group compared to the group of brachycephalic dogs.  

There seems to be an inconsistency regarding accessibility of the gyri on the left and right side 
of the brain in both approaches and both groups. This is especially prominent in brachycephalic 
dogs where for example the gyrus marginalis in the „Approach Brachycephalic“ was not 
exposed on the left side, but in three out of four dogs exposed on the right side. This also 
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shows in Table 13 where the gyrus endomarginalis in the “Approach Brachycephalic” is 
exposed 111.43% on the left and 0.00% on the right side for mesaticephalic dogs.  Another 
cause for this high variance is the fact that this gyrus was only accessed in one dog with a 
rather big, exposed gyrus area (compared to the mean gyrus endomarginalis area in 
mesaticephalic dogs) on the left and not at all on the right side. The 111.43% therefore are a 
mathematical problem. A possible explanation for the inconsistency in accessibility could be  
the lack of quality and resolution in some of the scans and as a consequence of this, an 
inaccuracy in the  drawing of the gyri, or the positioning of the affected gyri close to the edge 
of the craniotomy area. Another cause could be a certain degree of biological variance and 
asymmetry in the hemispheres (Toga and Thompson 2003). Furthermore, it is necessary to 
mention that the gyrus marginalis and gyrus endomarginalis could not be separated visually in 
Dog 7 (brachycephalic) and therefore it statistically only shows up as gyrus endomarginalis. 

The variability in the exposition of the different gyri in each approach might be due to the 
„Approach Mesaticephalic“ lying more caudally and dorsally and therefore not exposing the 
area just caudal to the sinus frontales, but also being bigger in general compared to the 
„Approach Brachycephalic“. However, it is important to mention that because of the high variety 
of skull shapes in brachycephalic dogs even throughout the same breeds and similar sizes. 
The location of the drill holes in the „Approach Brachycephalic“ was more directed towards 
safety and reproducibility throughout these  dogs and as a consequence led to a smaller 
craniotomy area than anticipated. Drill hole 1 of the „Approach Mesaticephalic“ appears to be 
appropriate for mesaticephalic dogs, but because of the different skull shapes of 
brachycephalics, and the drill holes´ reliance on the sutura parietofrontalis, its location varied 
highly. It led to a borderline impossible craniotomy in this area because of its extremely dorsal 
location (< 1 cm to the crista sagittalis externa) and the risk to lacerate the sinus sagittalis 
dorsalis. Therefore, the sutura parietofrontalis is not a recommended reference point in 
brachycephalic dogs but appears to be appropriate for mesaticephalic dogs, although the 
craniotomy comes close to the crista sagittalis externa as well. This very dorsal drill hole also 
affected the craniotomy area and the accessibility of gyri. As a result of these points, the 
comparison of both approaches in brachycephalic dogs must be treated with caution.  

To further improve accessibility of the brain in a craniotomy, it may be necessary to occlude 
parts of the sinus durae matris. Previous studies indicate no risk of an elevation of the 
intracranial pressure and no or transient neurologic deficits after unilateral acute or permanent 
occlusion of a sinus transversus. (Bagley et al. 1997, Boston 2010, Pluhar et al. 1996) Although 
a moderate increase of the intracranial pressure can be compensated, these mechanisms 
cannot cope with a persistent increase in intracranial pressure which can lead to life 
threatening conditions like cerebral ischemia and brain herniation. Therefore, an increased 
intracranial pressure influences the postoperative mortality rate. (Seki et al. 2019) Laceration 
or incision of the sinus durae matris leads to heavy bleeding, followed by cerebral hypotension 
as well as increased intracranial pressure due to haematoma. (Steyrer 2018) 
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The accessible brain area was bigger than the craniotomy area in seven of eight dogs in the 
“Approach Mesaticephalic”, with the Dog 1 being the outlier. In general, it must be considered 
that however big the craniotomy area is, the exposed area underneath it should be at least the 
same. However, in Dog 1 the difference in these two areas is due to the generally dorsal and 
caudal positioning of this particular approach (“Approach Mesaticephalic”) and the 
subsequently “misaligned” craniotomy which exposes tissue that isn’t counted towards brain 
tissue. This leads to a bigger craniotomy area, but the exposed brain area beneath it is smaller. 
Figure 48 and Figure 47 portray the difference of both approaches in Dog 1. 

A sinus frontalis is present in 7 out of 8 dogs, albeit one of these dogs has the sinus frontalis 
only on one side. This inconsistency regarding the presence of a sinus frontalis is only apparent 
in the brachycephalic group which corresponds with previous studies in this field. (Hermanson 
et al. 2020) Although there was an effort in the „Approach Brachycephalic“ not to damage the 
sinus frontalis,  because there is a risk of  bleeding, infection, and a possible  occurrence of a 
pneumocephalus, both sides of the sinus frontalis in three out of four mesaticephalic dogs were 
opened.  

The „Approach Mesaticephalic“ only opened the left sinus frontalis of two dogs from the 
mesaticephalic group and none of the brachycephalics, which could be due to the more caudal 
craniotomy position of his approach. To cope with this result in the „Approach Brachycephalic“ 
either a bigger safety margin for the drill hole 1 should be considered, or the pre-operative use 
of diagnostic imaging, namely CT, to determine how much safety margin is necessary to avoid 
any trepanation of the sinus frontalis. On one hand trepanation of the sinus frontalis bears a 
short term risk like bleeding of the mucosa - on the other hand postoperative complications like 
seizures, surgical site infection, intracranial haemorrhage, pneumocephalus, increasing 
intracranial pressure, CSF leakage and pneumonia are possible complications after a 
craniotomy. (Cavanaugh et al. 2008, M Das and Bajaj 2020, Marras et al. 1998, Seki et al. 
2019, Wohlgemuth 1985) 

One drawback of this study is the low number of cases. I was only able to obtain both, CT and 
MRI scans of the head, of four brachycephalic and four mesaticephalic dogs which is not an 
appropriate sample size to be diagnostically conclusive. For definitive conclusions regarding 
reproducibility and significance, further studies and greater case numbers are needed. 
Moreover, the brachycephalic group consisted only of French Bulldogs whereas the 
mesaticephalic group was more heterogeneous with one Golden Retriever and three mixed 
breeds who also were quite different in size and weight. Furthermore, a certain degree of 
inaccuracy is expected due to the visualization of a 3D object on a 2D screen. Moving and 

Figure 48: "Approach Brachycephalic" in Dog 1 Figure 47: Approach Mesaticephalic" in Dog 1 
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rotating the visualization on the screen often leads to a small variation of areas and therefore 
should be seen as source of error, albeit negligible. 

When both approaches are compared it is important to not only look at the sizes of the 
craniotomies or the accessible gyri, but also to look at the practicability and safety.  
In brachycephalic dogs the “Approach Mesaticephalic” provides a larger craniotomy area and 
a bigger access to some gyri, but safety must be considered when strictly following the guide. 
The craniotomy lies very dorsal which can provoke laceration of the sinus sagittalis dorsalis 
and then cause major complications. It needs to be considered, that such a big craniotomy 
might be viable when simulated on a computer and only bony structures are taken into account, 
but then in real life could interfere with the anatomy of the soft tissue and therefore decrease 
its practicability. In conclusion the newly designed “Approach Brachycephalic” is more feasible 
in brachycephalic dogs due to its safety and reproducibility and the “Approach Mesaticephalic” 
is best reserved for mesaticephalic dogs. 
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5 Summary 

A rostrotentorial craniotomy approach in brachycephalic dog breeds is described with its 
anatomical features and circumstances of brachycephalia and then compared to an already 
described approach in mesaticephalic dogs (Steyrer 2018) regarding its safety and 
consistency. 

For this, the Institute of Topographic Anatomy of the VUW provided specimen of 
brachycephalic dog breeds prior to the study which were examined for possible anatomical 
differences. 

Afterwards the Clinical Unit of Diagnostic Imaging of the VUW made the database available 
for the study. All mesati- and brachycephalic dogs with available CT and MRI scans of the skull 
since the year 2010 without pathologies of the brain were included in this study. The processing 
of these scans was done in Amira (Thermo Fischer Scientific) in the version 2019.01. 

The skulls were measured in Amira and based on follow-up calculations split into two groups 
(mesati- and brachycephalic). Additionally, they were scanned for anatomical variations inside 
the skull. A substantial difference in these two skull shapes is the presence and extent of the 
bilateral sinus frontalis as well as the median crista sagittalis externa and the protuberantia 
occipitalis. 

To ensure a safe surgical approach, the maximal expansion of the sinus frontales, the 
protuberantia occipitalis and the crista sagittalis externa were measured and the approach 
from Steyrer (2018) under consideration of appropriate safety margins was amended. 

Subsequently the already described as well as the newly designed craniotomy approaches 
were simulated virtually on all skulls. The craniotomy area together with the according gyri area 
was measured and furthermore both approaches were compared and statistically analysed. 

The results show that the newly adapted craniotomy approach in brachycephalic dogs exposes 
a variety of gyri. The majority of the gyrus ectosylvius rostralis, gyrus ectosylvius caudalis, 
gyrus suprasylvius rostralis, gyrus suprasylvius medius, gyrus suprasylvius caudalis and entire 
gyrus ectosylvius media are exposed.  

The following Table 14 compares the mean accessible area of each gyrus in percent of both 
approaches and both skull shapes. 
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Table 14: Comparison of the mean access to the area of each individual gyrus in % 

Comparison of the mean access to the gyri area in % 

gyrus 
brachycephalic dogs mesaticephalic dogs 

Approach  
brachycephalic 

Approach 
mesaticephalic 

Approach  
brachycephalic 

Approach 
mesaticephalic 

gyrus sylvius rostralis 35.53 28.79 73.54 69.60 
gyrus sylvius caudalis 28.15 26.31 44.24 45.17 
gyrus ectosylvius rostralis 62.47 43.23 98.26 94.34 
gyrus ectosylvius medius 100.00 92.48 97.58 100.00 
gyrus ectosylvius caudalis 54.92 57.51 55.01 65.40 
gyrus suprasylvius rostralis 58.74 43.00 88.68 78.09 
gyrus suprasylvius medius 96.74 80.17 54.90 100.00 
gyrus ectomarginalis 33.37 76.00 19.71 87.74 
gyrus suprasylvius caudalis 64.15 74.05 19.00 57.29 
gyrus occipitalis 5.34 70.77 0.00 44.09 
gyrus marginalis 6.84 80.23 39.24 80.92 
gyrus endomarginalis 4.22 10.59 55.72 79.37 
gyrus postcruciatus 15.13 2.37 72.81 60.41 
gyrus praecruciatus 0.65 0.00 63.40 9.18 
gyrus proreus 0.00 0.00 20.98 8.50 

The comparability to the approach from Steyrer (2018) is to be taken cautiously, because 
strictly following the guide leads to an impossible craniotomy in brachycephalic dogs which 
would risk a laceration of the sinus sagittalis dorsalis.  

Furthermore, this study agrees with previous findings, that the sinus frontalis is inconsistent in 
brachycephalic dogs. The “Approach Mesaticephalic” opened at least one sinus frontalis in two 
out of eight dogs, both mesaticephalic. The “Approach Brachycephalic” lead to trepanation of 
no brachycephalic, but three mesaticephalic dogs. This means that in this study both 
approaches were safe regarding opening of the sinus frontales in brachycephalic, but not for 
mesaticephalic dogs. 

In conclusion the newly designed “Approach Brachycephalic” is more feasible in 
brachycephalic dogs due to its safety and reproducibility and the “Approach Mesaticephalic” is 
best for mesaticephalic dogs. 
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6 Zusammenfassung 

Ein bereits beschriebener rostrotentorialer Kraniotomiezugang bei mesaticephalen 
Hunderassen (Steyrer 2018) wird auf die anatomischen Gegebenheiten und Besonderheiten 
von brachycephalen Hunden angepasst um auch bei diesen einen möglichst sicheren und 
dennoch zweckdienlichen chirurgischen Zugang zu erhalten. 

Dazu wurden im Vorfeld Schädelknochenpräparate von brachycephalen Hunderassen des 
Instituts für Topographische Anatomie der VUW auf allfällige Besonderheiten in deren 
Anatomie untersucht und größere Auffälligkeiten festgehalten.  

In der Folge stellte die klinische Abteilung für Bildgebende Diagnostik der VUW Ihre Datenbank 
für den eigentlichen Versuch zur Verfügung. Alle seit 2010 verfügbaren CT und MRI Scans 
physiologischer Schädel von mesati- und brachycephalen Hunden wurden in die Studie 
inkludiert. Die Verarbeitung dieser Scans erfolgte mithilfe des Programms Amira (Thermo 
Fischer Scientific) in der Version 2019.01. 

Die Schädelknochen wurden in Amira vermessen und auf Basis der anschließenden 
Berechnungen in zwei Gruppen (mesati- und brachycephal) eingeteilt. Zusätzlich wurden sie 
auf anatomische Variationen innerhalb des Schädelknochens untersucht. Ein wesentlicher 
Unterschied der beiden Schädelformen ist das Vorhandensein und die Ausprägung des 
beidseitigen Sinus frontalis sowie der medianen Crista sagittalis externa und der Protuberantia 
occipitalis. 

Um einen sicheren Zugang zu gewährleisten wurde die Maximalausdehnung der Sinus 
frontales, der Protuberantia occipitalis und der Crista sagittalis externa in Amira ausgemessen 
und der von Steyrer (2018) beschriebene Zugang unter Bedachtnahme auf entsprechende 
Sicherheitsabstände abgeändert.  

Danach wurden sowohl der bereits beschriebene als auch der neu konzipierte 
Kraniotomiezugang virtuell an allen Schädeln simuliert und die Kraniotomieflächen sowie die 
freigelegte Fläche des Gehirns und der Gyri ausgemessen. Weiterführend wurden die beiden 
Zugänge miteinander verglichen und statistisch ausgewertet. 

Die Ergebnisse zeigen, dass der neu angepasste Kraniotomiezugang bei brachycephalen 
Hunderassen eine Vielzahl an Gyri freilegt. Der Großteil des Gyrus ectosylvius rostralis, Gyrus 
ectosylvius caudalis, Gyrus suprasylvius rostralis, Gyrus suprasylvius medius, Gyrus 
suprasylvius caudalis und der gesamte Gyrus ectosylvius medius werden dargestellt. 

Die folgende Table 15 vergleicht die durchschnittlich zugängliche Fläche jedes einzelnen 
Gyrus in Prozent von beiden Zugängen und Schädelformen. 
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Table 15: Vergleich der durchschnittlich zugänglichen Fläche der einzelnen Gyri in %  

Vergleich der durchschnittlich zugänglichen Gyri Fläche in % 

Gyrus 
Brachycephale Hunde Mesaticephale Hunde 
Zugang 

brachycephal 
Zugang 

mesaticephal 
Zugang 

brachycephal 
Zugang 

mesaticephal 
Gyrus sylvius rostralis 35.53 28.79 73.54 69.60 
Gyrus sylvius caudalis 28.15 26.31 44.24 45.17 
Gyrus ectosylvius rostralis 62.47 43.23 98.26 94.34 
Gyrus ectosylvius medius 100.00 92.48 97.58 100.00 
Gyrus ectosylvius caudalis 54.92 57.51 55.01 65.40 
Gyrus suprasylvius rostralis 58.74 43.00 88.68 78.09 
Gyrus suprasylvius medius 96.74 80.17 54.90 100.00 
Gyrus ectomarginalis 33.37 76.00 19.71 87.74 
Gyrus suprasylvius caudalis 64.15 74.05 19.00 57.29 
Gyrus occipitalis 5.34 70.77 0.00 44.09 
Gyrus marginalis 6.84 80.23 39.24 80.92 
Gyrus endomarginalis 4.22 10.59 55.72 79.37 
Gyrus postcruciatus 15.13 2.37 72.81 60.41 
Gyrus praecruciatus 0.65 0.00 63.40 9.18 
Gyrus proreus 0.00 0.00 20.98 8.50 

 
Die Vergleichbarkeit mit dem Zugang von Steyrer (2018) ist vorsichtig zu beurteilen, da dieser 
bei strikter Ausführung bei brachycephalen Hunden zu nicht geeigneten Kraniotomien führt 
welche ein Risiko der Verletzung des Sinus sagittalis dorsalis bergen. 

Weiters stimmt diese Diplomarbeit mit vorherigen Berichten einer Inkonsistenz der Sinus 
frontales bei brachycephalen Hunden überein. Der „Approach Mesaticephalic“ öffnete 
mindestens einen Sinus frontalis bei zwei von acht Hunden, beide mesaticephal. Der 
„Approach Brachycephalic“ führte zu keiner Öffnung bei brachycephalen, aber zur Öffnung 
des Sinus frontalis von drei mesaticephalen Hunden. Daher kann man sagen, dass beide 
Zugänge sicher für brachycephale, aber nicht für mesaticephale Hunde sind. 

Zusammenfassend kann man sagen, dass der neu beschriebene „Approach Brachycephalic“ 
aufgrund der höheren Gefahrlosigkeit und Reproduzierbarkeit bei brachycephalen Hunden 
besser geeignet ist und daher bei diesen bevorzugt werden sollte. Der „Approach 
Mesaticephalic“ erzielt bei mesaticephalen Hunden gute Ergebnisse und sollte deswegen auch 
bei diesen angewandt werden. 
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7 Appendix 

 

7.1 Translation-sheet 

By virtue of the nomenclatures used in this thesis being Latin, but many other publications 
using English as their terminology, I have added a Translation-sheet. 

Nomina Anatomica Veterinaria English 
A. basilaris basilar artery 
A. carotis communis common carotid artery 
A. carotis interna internal carotid artery 
A. cerebri caudalis caudal cerebral artery 
A. cerebri media middle cerebral artery  
A. cerebri rostralis rostral cerebral artery 
A. choroidea rostralis rostral choroidal artery 
A. communicans caudalis Caudal communicating artery 
A. ethmoidalis interna internal ethmoidal artery 
A. hypophysialis caudalis caudal hypophyseal artery 
A. intercarotica caudalis caudal intercarotid artery 
A. intercarotica rostralis rostral intercarotid artery 
A. ophthalmica interna internal ophthalmic artery 
A. vertebralis vertebral artery 
Aa. cerebelli caudles caudal cerebellar arteries 
Aa. labyrinthi labyrinth arteries 
Aqueductus mesencephali Mesencephalic aqueduct 
Arachnoidea encephali Arachnoid mater 
Basis cranii interna Cranial base 
Bulbus olfactorius Olfactory bulb 
C. magna cerebri great cerebral vein 
Canalis carotideus carotid canal 
Canalis opticus  Optic canal 
Canalis petrooccipitalis Petrooccipital canals 
Canalis sinus transversi Transverse canal 
Canalis vertebralis Vertebral canal 
Cavum cranii Cranial cavity 
Cavum nasii Nasal cavity 
Cavum subarachnoidale Subarachnoid space 
Cavum subarachnoidale Subarachnoid space 
Chiasma opticum Optic chiasm 
Chiasma opticum optic chiasm 
Cisterna cerebellomedullaris Cisterna magna 
Cisterna chiasmatis Chiasmatic cistern 
Cisterna interpeduncularis Interpeduncular cistern 
Cisterna valleculae lateralis cerebri Cistern of lateral cerebral fossa 
Commissura rostralis Rostral commissure 
Condylus occipitalis Occipital condyle 
Confluens sinuum  Confluence of the sinuses 
Cortex auditivus (human med) Auditory cortex 
Cortex cerebri Cerebral cortex 
Cortex frontalis Frontal lobe 
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Cortex occipitalis Occipital lobe 
Cortex parietalis Parietal lobe 
Cortex temporalis Temporal lobe 
Crus cerebri Crus cerebri 
Dentes canini Canine 
Dentes praemolares Premolar 
Dentes incisivi Incisor 
Diaphragma sellae Sellar diaphragm 
Encephalon Brain 
Epithalamus Epithalamus 
Fissura longitudinalis cerebri Median longitudinal fissure 
Fissura longitudinalis cerebri longitudinal fissure 
Fissura orbitalis Orbital fissure 
Fissura pseudosylvia pseudosylvian fissure 
Fissura tympanooccipitalis tympanooccipital fissure 
Fissura uvulonodularis Uvunodular fissure 
Foramen jugulare Jugular foramen 
Foramen vertebrale Vertebral foramen 
Formatio reticularis Reticular formation 
Fossa cranii media Middle cranial fossa 
Gyrus proreus prorean gyrus 
Hamulus pterigoidei Pterygoid hamulus 
Hemispheria cerebri Cerebral hemispheres 
Lamina cribrosa Cribriform plate 
Lamina cribrosa cribriform plate 
Liquor cerebrospinalis Cerebrospinal fluid 
Ln. retropharyngeus medialis medial retropharyngeal lymph node 
Lobus flocculonodularis Flocculonodular lobe 
Lobus piriformis Piriform lobe 
Lobus piriformis Piriform lobe 
Meatus acusticus externus External acoustic meatus 
Meatus acusticus externus External acoustic meatus 
Meatus temporalis Temporal meatus 
Medulla spinalis Spinal cord 
Mesencephalon Midbrain 
Nervi craniales Cranial nerves 
Nervus olfactorius Olfactory nerve 
Nervus trochlearis Fourth cranial nerve 
Nuclei basales basal nuclei 
Nuclei geniculi geniculate nucleus 
Nuclei olivares olives 
Nucleus accumbens Accumbens 
Nucleus caudatus caudate nucleus 
Nucleus endopeduncularis endopeduncular nucleus 
Nucleus ruber red nucleus 
Nucleus subthalamicus subthalamic nucleus 
Os basisphenoidale Basisphenoid bone 
Os ethmoidale Ethmoid bone 
Os frontale Frontal bone 
Os interparietale Interparietal bone 
Os occipitale Occipital bone 
Os parietale Parietal bone 
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Os praesphenoidale Presphenoid bone 
Os temporale Temporal bone 
Pedunculus cerebri Cerebral peduncles 
Plexus choroideus choroid plexus 
Plexus choroideus choroid plexus 
Plexus ophtalmicus Ophtalmic plexus of veins 
Plexus venosus vertebralis internus Ventral internal vertebral venous plexus 
Polus caudalis Occipital pole 
Polus rostralis Frontal pole 
Processus frontalis ossis zygomaticus Frontal process of zygomatic bone 
Processus interparietalis ossis occipitalis Interparietal process of the occipital bone 
Processus mastoideus Mastoid process 
Processus nasalis Nasal process 
Processus zygomaticus ossis frontalis Zygomatic process of frontal bone 
Protuberantia occipitalis externa Occipital protuberance 
Rr. Ad pontem Pontine branches 
Rr. centrales Central branches 
Rr. corticales Cortical branches 
Rr. striati Striatic branches 
Septum nasi osseum Osseous nasal septum 
Sinus basilaris Basilar sinus 
Sinus caroticus carotid sinus 
Sinus durae matris Sinus of the dura mater 
Sinus frontalis Frontal sinus 
Sinus intercavernosi Intercavernous sinus 
Sinus petrosus dorsalis Dorsal petrosal sinus 
Sinus petrosus ventralis Ventral petrosal sinus 
Sinus petrosus ventralis Ventral petrosal sinus 
Sinus rectus Straight sinus 
Sinus sagittalis dorsalis Dorsal sagittal sinus 
Sinus sagittalis dorsalis Dorsal sagittal venous sinus 
Sinus sigmoideus Sigmoid sinus 
Sinus sigmoideus Sigmoid sinus 
Sinus temporalis Temporal sinus 
Sinus transversus Transverse sinus 
Substantia alba  White matter 
Substantia grisea Grey matter 
Subthalamus Subthalamus 
Sulcus ansatus ansate sulcus 
Sulcus coronalis coronal sulcus 
Sulcus cruciatus cruciate sulcus 
Sulcus hippocampi hippocampal sulcus 
Sulcus sinus transversi Transverse groove 
Sutura coronalis Frontoparietal suture 
Sutura frontonasalis Frontonasal suture 
Sutura interincisiva Inter incisive suture 
Sutura internasalis Internasal suture 
Sutura sagittalis Sagittal suture 
Systema nervosum centrale Central nervous system 
Tentorium cerebelli membranaceum Membranous cerebellar tentorium 
Tentorium cerebelli osseum Osseous cerebellar tentorium 
Tractus olfactorius Olfactory tract 
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Truncus encephali  Brainstem 
Tuberculum nuchale  Nuchal tubercle 
Tunica adventitia Adventitia 
Tunica media Middle coat 
V. angularis oculi angular vein of the eye 
V. cerebri magna Great cerebral vein 
V. corporis callosi Vein of the corpus callosum 
V. diploica  Diploic vein 
V. diploica frontalis frontal diploic vein 
V. diploica occipitalis occipital diploic vein 
V. diploica parietalis parietal diploic vein 
V. diploica parietalis parietal diploic vein 
V. emissaria foraminis ovalis emissary vein of the oval foramen 
V. thalamostriata thalamostriate vein 
Ventriculus lateralis Lateral ventricle 
Ventriculus quartus Fourth ventricle 
Ventriculus tertius Third ventricle 
Ventriculus tertius third ventricle 
Vermis Median vermis 
Viscerocranium (human med) viscerocranium 
Vv. Cerebelli dorsales dorsal cerebellar veins 
Vv. cerebri dorsales Dorsal cerebral veins 
Vv. Cerebri dorsales dorsal cerebral veins 
Vv. Cerebri internae Internal cerebral veins 
Vv. choroidea Choroidal veins 
Vv. diploicae Diploic veins 
Vv. medullares Medullary veins 
Vv. meningeae meningeal veins 
Vv. pontis pontine veins 
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7.2 Measurements from Amira 

 

Table 16: Morphometric measurements in mm 

Morphometric measurements in mm 
 Facial 

length 
Facial 
width 

Cranial 
length 

Cranial 
width 

Cranial 
height 

Skull 
length 

Skull base 
length 

Dog 1 97.10 115.00 112.30 67.74 71.48 208.10 187.30 
Dog 2 91.40 102.40 115.00 60.75 59.24 205.60 181.50 
Dog 3 84.39 104.00 108.00 62.54 56.77 192.10 174.40 
Dog 4 49.36 77.45 73.58 48.91 46.04 123.80 109.70 
Dog 5 24.29 95.43 84.43 60.26 53.93 108.60 89.51 
Dog 6 31.61 112.80 89.47 63.09 51.99 121.10 97.38 
Dog 7 38.72 125.90 93.64 61.67 55.31 132.70 114.60 
Dog 8 40.25 127.00 84.18 57.70 54.97 125.50 109.30 

 

Table 17: Craniotomy area Approach Schlager in mm 

Craniotomy area in mm 
 Approach Schlager left Approach Schlager right 
Dog 1 2101.95 2047.12 
Dog 2 1211.06 1226.38 
Dog 3 1175.94 1300.62 
Dog 4 594.91 633.16 
Dog 5 953.43 1086.99 
Dog 6 1395.03 1501.44 
Dog 7 1448.56 1524.79 
Dog 8 1053.52 1164.69 

 

Table 18: Craniotomy area Approach Steyrer in mm 

Craniotomy area in mm 
  Approach Steyrer left Approach Steyrer right 
Dog 1 2349.87 2497.22 
Dog 2 1927.74 1698.74 
Dog 3 1718.64 1600.20 
Dog 4 1017.29 1099.07 
Dog 5 1511.92 1603.53 
Dog 6 1867.89 1645.71 
Dog 7 1808.47 1965.71 
Dog 8 1413.71 1388.72 
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Table 19: Gyri area in mm Dog 1 

Gyri area in mm 

Dog 1 brain Approach Schlager Approach Steyrer 
left right left right left right 

total area 6959.53 6767.55 1955.82 1673.26 2160.55 2244.88 
undefined 2782.24 2516.44     

Cortex 4177.29 4251.11     

Gyrus sylvius rostralis 195.75 107.30 185.79 78.05 174.09 87.43 
Gyrus sylvius caudalis 112.94 127.10 78.40 82.15 63.39 97.11 
Gyrus ectosylvius rostralis 166.35 128.74 166.78 128.74 166.35 128.74 
Gyrus ectosylvius medius 100.78 111.53 87.53 111.53 100.78 111.53 
Gyrus ectosylvius caudalis 189.89 115.50 134.45 44.17 155.61 68.26 
Gyrus suprasylvius rostralis 251.65 293.08 251.65 275.42 239.26 278.45 
Gyrus suprasylvius medius 203.95 172.73 77.45 133.68 203.95 172.73 
Gyrus ectomarginalis 243.10 291.45 57.30 55.52 217.44 288.80 
Gyrus suprasylvius caudalis 247.35 287.50 0.12 60.46 103.61 134.59 
Gyrus occipitalis 222.44 210.70   90.57 72.78 
Gyrus marginalis 36.65 51.80 25.49 23.32 36.65 51.80 
Gyrus endomarginalis 74.43 74.29 59.72  45.77 61.04 
Gyrus postcruciatus 330.01 352.53 330.01 292.57 219.31 300.00 
Gyrus praecruciatus 137.06 95.31 98.66 51.75   

Gyrus proreus 230.84 259.82 97.87 76.31  33.77 

 

Table 20: Gyri area in mm Dog 2 

Gyri area in mm 

Dog 2 
brain Approach Schlager Approach Steyrer 

left right left right left right 
total area 6247.73 6579.66 1355.92 1404.23 1921.84 1948.63 
undefined 2298.55 2690.78    4.48 
Cortex 3949.18 3888.87     

Gyrus sylvius rostralis 126.61 172.43 120.46 121.00 117.58 90.39 
Gyrus sylvius caudalis 186.44 219.62 77.12 79.60 66.98 86.56 
Gyrus ectosylvius rostralis 146.40 221.53 137.34 220.38 132.12 194.92 
Gyrus ectosylvius medius 128.95 148.56 128.95 148.56 128.95 148.56 
Gyrus ectosylvius caudalis 174.82 153.92 136.90 60.62 125.16 77.62 
Gyrus suprasylvius rostralis 242.24 149.45 217.22 142.92 189.05 140.98 
Gyrus suprasylvius medius 156.06 258.15 106.61 108.62 156.06 258.15 
Gyrus ectomarginalis 243.11 220.89 20.90 6.78 208.92 172.62 
Gyrus suprasylvius caudalis 198.57 165.08 9.65 90.20 132.29 127.45 
Gyrus occipitalis 145.14 137.21   40.40 58.23 
Gyrus marginalis 62.47 43.34   62.47 43.34 
Gyrus endomarginalis 67.65 56.07   48.93 53.56 
Gyrus postcruciatus 237.47 170.75 36.77 53.13 146.69 139.79 
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Gyrus praecruciatus 236.17 227.42 89.24 100.74 1.78 23.21 
Gyrus proreus 255.04 216.20 10.68 18.47   

Table 21: Gyri area in mm Dog 3 

Gyri area in mm 

Dog 3 brain Approach Schlager Approach Steyrer 
left right left right left right 

total area 6852.56 6765.42 1319.51 1516.13 1723.80 1602.78 
undefined 3167.88 3111.68     

Cortex 3684.68 3653.74     

Gyrus sylvius rostralis 195.85 142.34 90.34 91.48 92.04 92.41 
Gyrus sylvius caudalis 141.30 164.39 32.50 34.98 32.94 50.44 
Gyrus ectosylvius rostralis 110.16 179.82 110.16 174.18 107.16 157.06 
Gyrus ectosylvius medius 166.31 120.61 159.19 120.61 166.31 120.61 
Gyrus ectosylvius caudalis 129.65 109.67 59.46 34.75 65.53 60.22 
Gyrus suprasylvius rostralis 220.10 149.67 216.58 136.29 165.15 76.76 
Gyrus suprasylvius medius 128.23 146.66 114.73 144.10 128.23 146.66 
Gyrus ectomarginalis 222.33 255.31 35.30 92.03 190.70 224.02 
Gyrus suprasylvius caudalis 326.25 252.46 2.07 115.65 187.35 181.76 
Gyrus occipitalis 114.10 157.44   63.31 73.50 
Gyrus marginalis 42.12 49.23  2.83 42.12 49.23 
Gyrus endomarginalis 50.44 27.93   45.96 20.94 
Gyrus postcruciatus 180.05 174.91 92.01 112.63 124.22 53.80 
Gyrus praecruciatus 194.12 148.53 144.15 99.05   

Gyrus proreus 164.08 173.98 22.58 15.89   

 

Table 22: Gyri area in mm Dog 4 

Gyri area in mm 

Dog 4 brain Approach Schlager Approach Steyrer 
left right left right left right 

total area 4602.65 4613.87 659.83 690.27 1081.66 1191.63 
undefined 1992.39 2167.81   0.49 1.09 
Cortex 2610.25 2446.06     

Gyrus sylvius rostralis 63.40 120.23 55.49 85.51 55.20 75.39 
Gyrus sylvius caudalis 61.03 99.61 44.53 60.49 49.83 58.20 
Gyrus ectosylvius rostralis 95.94 87.08 95.94 82.66 95.98 87.08 
Gyrus ectosylvius medius 108.55 108.86 106.22 107.19 108.55 108.86 
Gyrus ectosylvius caudalis 101.81 106.56 67.33 70.43 89.84 73.82 
Gyrus suprasylvius rostralis 257.19 227.93 201.98 150.48 135.90 168.77 
Gyrus suprasylvius medius 132.08 116.68 24.28 14.28 132.08 116.68 
Gyrus ectomarginalis 161.53 166.97   123.07 159.59 
Gyrus suprasylvius caudalis 194.54 159.61  48.16 89.49 88.31 
Gyrus occipitalis 118.38 100.45     
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Gyrus marginalis 60.32 43.20   6.76 21.48 
Gyrus endomarginalis 21.85 34.49    1.79 
Gyrus postcruciatus 106.89 127.38   7.32 23.11 
Gyrus praecruciatus 122.01 64.84     

Gyrus proreus 97.85 144.84     

Table 23: Gyri area in mm Dog 5 

Gyri area in mm 

Dog 5 brain Approach Schlager Approach Steyrer 
left right left right left right 

total area 6371.50 6601.42 1058.23 1146.10 1714.42 1724.93 
undefined 2060.18 2308.48   152.37 89.88 
Cortex 4311.32 4292.94     

Gyrus sylvius rostralis 255.82 222.70 70.39 51.94 63.61 45.00 
Gyrus sylvius caudalis 119.52 202.17 7.81 17.17 10.89 23.27 
Gyrus ectosylvius rostralis 122.75 304.11 67.59 142.46 42.07 111.08 
Gyrus ectosylvius medius 216.80 147.79 216.80 147.79 216.80 147.79 
Gyrus ectosylvius caudalis 196.86 242.60 155.17 157.94 166.72 173.04 
Gyrus suprasylvius rostralis 207.46 158.42 52.34 114.58 31.65 29.88 
Gyrus suprasylvius medius 148.58 277.38 148.58 232.04 112.92 181.61 
Gyrus ectomarginalis 262.21 367.66 54.00 1.07 161.14 306.37 
Gyrus suprasylvius caudalis 375.41 235.84 149.82 114.70 240.44 160.61 
Gyrus occipitalis 286.58 233.17   238.48 196.83 
Gyrus marginalis 53.87 58.36     

Gyrus endomarginalis 59.74 36.47     

Gyrus postcruciatus 294.26 252.57     

Gyrus praecruciatus 258.12 323.68     

Gyrus proreus 168.12 151.12     

 

Table 24: Gyri area in mm Dog 6 

Gyri area in mm 

Dog 6 brain Approach Schlager Approach Steyrer 
left right left right left right 

total area 8087.50 7821.14 1591.06 1673.27 1925.33 1776.03 
undefined 3268.54 3280.30 16.52 30.40 198.93 188.07 
Cortex 4818.96 4540.84     

Gyrus sylvius rostralis 196.09 211.77 101.90 85.48 71.21 52.93 
Gyrus sylvius caudalis 146.32 118.92 43.76 62.22 42.24 63.43 
Gyrus ectosylvius rostralis 189.56 287.56 131.96 132.14 65.94 26.01 
Gyrus ectosylvius medius 175.22 153.76 175.22 153.76 137.22 95.30 
Gyrus ectosylvius caudalis 391.13 370.13 276.96 231.27 269.66 252.38 
Gyrus suprasylvius rostralis 356.84 142.60 132.89 84.87   

Gyrus suprasylvius medius 115.01 210.53 115.01 210.53 79.20 84.77 
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Gyrus ectomarginalis 287.13 290.91 78.55 179.78 180.05 155.15 
Gyrus suprasylvius caudalis 208.06 302.56 203.20 237.35 207.91 260.07 
Gyrus occipitalis 343.58 337.58 25.11 20.97 343.07 325.56 
Gyrus marginalis 80.62 94.25  5.23   

Gyrus endomarginalis 153.81 207.64   4.07 22.93 
Gyrus postcruciatus 278.86 166.46 1.91 0.46   

Gyrus praecruciatus 271.85 302.99     

Gyrus proreus 151.61 90.56     

Table 25: Gyri area in mm Dog 7 

Gyri area in mm 

Dog 7 brain Approach Schlager Approach Steyrer 
left right left right left right 

total area 6765.00 6564.62 1599.57 1752.20 1977.30 1998.80 
undefined 2514.78 2120.78  9.02 60.67 23.66 
Cortex 4250.22 4443.84     

Gyrus sylvius rostralis 187.53 78.19 111.82 40.06 74.59 45.40 
Gyrus sylvius caudalis 61.39 32.58 53.35 3.67 48.28 11.89 
Gyrus ectosylvius rostralis 95.90 108.44 95.90 74.26 89.91 68.81 
Gyrus ectosylvius medius 135.33 191.06 135.33 191.06 135.33 191.06 
Gyrus ectosylvius caudalis 290.38 442.32 176.53 183.07 163.11 202.57 
Gyrus suprasylvius rostralis 408.06 532.85 286.14 308.87 169.24 181.90 
Gyrus suprasylvius medius 126.17 221.22 125.85 215.85 126.17 205.90 
Gyrus ectomarginalis 214.21 147.11 56.54 84.48 214.21 147.11 
Gyrus suprasylvius caudalis 435.61 461.71 292.65 308.86 269.51 374.61 
Gyrus occipitalis 306.63 305.12 4.19 10.89 273.24 191.16 
Gyrus marginalis 238.95 84.39  29.39 95.68 69.37 
Gyrus endomarginalis 166.58 10.62 35.32 
Gyrus postcruciatus 170.03 216.12 61.24 68.98 5.72 2.21 
Gyrus praecruciatus 269.56 396.79 2.52    

Gyrus proreus 136.37 102.28     

 

Table 26: Gyri area in mm Dog 8 

Gyri area in mm 

Dog 8 brain Approach Schlager Approach Steyrer 
left right left right left right 

total area 6329.12 6666.73 1259.77 1312.62 1536.54 1466.23 
undefined 2187.77 2870.10  12.73 18.31 9.76 
Cortex 4141.36 3796.62     

Gyrus sylvius rostralis 239.65 154.07 47.16 44.99 48.10 45.26 
Gyrus sylvius caudalis 71.73 20.96 1.71  1.86 1.52 
Gyrus ectosylvius rostralis 150.02 178.01 102.78 121.76 89.28 101.41 
Gyrus ectosylvius medius 163.61 120.22 163.61 120.22 163.61 120.22 
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Gyrus ectosylvius caudalis 383.04 278.70 124.37 117.57 124.68 140.34 
Gyrus suprasylvius rostralis 323.25 313.95 237.90 211.80 205.49 168.46 
Gyrus suprasylvius medius 162.55 183.28 160.37 179.82 162.55 181.70 
Gyrus ectomarginalis 281.02 229.08 121.30 117.76 239.84 176.39 
Gyrus suprasylvius caudalis 170.30 279.98 126.86 149.88 145.56 171.31 
Gyrus occipitalis 226.47 253.66   18.11 37.55 
Gyrus marginalis 101.44 101.02  0.06 87.68 71.32 
Gyrus endomarginalis 91.37 93.42    6.64 
Gyrus postcruciatus 229.74 130.38 12.76 44.58 2.97 9.03 
Gyrus praecruciatus 351.06 421.36  1.47   

Gyrus proreus 115.10 83.07     

Table 27: Sinus frontalis 

Sinus frontalis 
 existence Approach Schlager Approach Steyrer 

left right left right left right 
Dog 1 Yes Yes Yes Yes No No 
Dog 2 Yes Yes Yes Yes Yes No 
Dog 3 Yes Yes Yes Yes Yes No 
Dog 4 Yes Yes No No No No 
Dog 5 No Yes No No No No 
Dog 6 No No No No No No 
Dog 7 Yes Yes No No No No 
Dog 8 Yes Yes No No No No 
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7.3 Statistics 

 

Table 28: Statistics Gyrus sylvius rostralis 
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Table 29: Statistics Gyrus sylvius caudalis 

 

  



65 

 

Table 30: Statistics Gyrus ectosylvius rostralis 
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Table 31: Statistics Gyrus ectosylvius medius 
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Table 32: Statistics Gyrus ectosylvius caudalis 
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Table 33: Statistics Gyrus suprasylvius rostralis 
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Table 34: Statistics Gyrus suprasylvius medius 
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Table 35: Statistics Gyrus ectomarginalis 
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Table 36: Statistics Gyrus suprasylvius caudalis 
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Table 37: Statistics Gyrus occipitalis 
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Table 38: Fisher test Gyrus occipitalis 

 

 

 

 

 

Table 39: Statistics Gyrus marginalis 
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Table 40: Statistic tests Gyrus marginalis 
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Table 41: Statistics Gyrus endomarginalis 
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Table 42: chi-square test Gyrus endomarginalis 
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Table 43: Statistics Gyrus postcruciatus 
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Table 44: Fisher test Gyrus postcruciatus 

 

 

 

 

 

Table 45: Statistics Gyrus praecruciatus 
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Table 46: Statistic tests Gyrus praecruciatus 
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Table 47: Statistics Gyrus proreus 
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Table 48: Fisher test Gyrus proreus 

 

 

 

Table 49: Statistics craniotomy and gyri area 

 

  



82 

 

Table 50: Statistics craniotomy sides compared 
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Table 51: Statistics approaches compared 
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Table 52: Statistics morphometric analysis 
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7.4 Standard Operating Procedure 

 

The Standard Operating Procedure was written in collaboration with Dr.rer.nat. Stephan 
Handschuh. 

1 Load and save images: 

1.1. Open a new project in Amira. 

1.2. “Open Data…” and select all files in the folder “CT”, then click “OK” 

 

Figure 49: Amira home 

 

Figure 50: Amira import 
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1.3. The stack of images is now loaded and can be visualised with “Volren” 

1.4.  

1.5. Load the stack of MRI images. If there are several sequences/weightings available, it 

is important to check which have the best quality. This is done by loading the stack, 

visualising it with “Volren” (see 1.3) and then changing the transparency/colour by 

sliding the brackets. Look for how good the Gyri are definable and how well they are 

visible. 

1.6.  

Figure 52: Amira Volren2 

Figure 51: Amira Volren 
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1.7. Both stacks are saved as “petname_CT.am” or “petname_Info.am” (example: 

“name_T2_TSE_SPACE.am”) 

 

Figure 53: Amira saving 

2 Orientation: 

2.1. Enable the “Global Axes” in the menu “View” and set the 3D Viewer to “Orthographic” 

in order to get rid of the otherwise occurring distortion. 

 

Figure 54: Amira view     Figure 55: Amira axes 
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2.2. Visualize the CT stack by right clicking it → “Isosurface”  

 

Figure 56: Amira tools 

2.3. In the properties, choose a threshold of 350 

 

Figure 57: Amira Isosurface 
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2.4. Turn on the “Transform Editor” and align the skull according to the following images. 

 

Figure 58: Amira transform 

 

 

Figure 59: landmarks (Hermanson et al. 2020) 
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2.5. The Prosthion and the Meatus acusticus externus should lie horizontally in one line 

with the Prosthion on the left side. Use the Global Axes as guidance. 

 

Figure 60: Amira aligning 

2.6. Switch between “XZ”, “XY” and “YZ” view to further align the skull on all axes. 

 

Figure 61: Amira aligning 2 
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2.7. Now enable the Scalebars by Right Click into the Project View → Create Object → 

Scalebars and under Properties tick the “Grid” to enable it and precisely align the skull. 

 

Figure 62: Amira scalebars 

 

Figure 63: Amira scalebars settings 
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2.8. Make sure to check the “Transform Editor” if the “Scale factor” is 1 in all three boxes 

and then save the stack. 

 

Figure 64: Amira transform editor settings 

 

 

3 Landmarks: 

 
3.1. Right Click into the Project View → Create Object → Point and Lines → 

Landmarks 

 

Figure 65: Amira landmarks 
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3.2. Open the Isosurface tool (Threshold 350, see 2.3), then use the “Landmark Editor” to 

add and edit landmarks with the “Interact” tool.  

 

Figure 66: Amira landmark editor 

 

Figure 67: Amira Interact 

 

3.3. Set the following landmarks in the correct order: 

Table 53: Amira landmarks 

Number Designation Info 

1 Bregma Difficult, look for an 
indentation 

2 Inion Most caudal point of 
Protuberantia occipitalis 

3 Midpoint of Bregma and Inion “Measurement tool” 
4 Processus nasalis sinister Rostral view 
5 Processus nasalis dexter Rostral view 
6 Sutura internasalis, most rostral point Rostral view 
7 Nasion Indentation 
8 Processus frontalis ossis zygomaticus sinister Dorsal view 



94 

 

9 Processus zygomaticus ossis frontalis sinister Lateral view 

10 Canalis opticus sinister, medioventrally 
In Fossa occuli; use “Ortho 
Slice” and “Clip” for better 
visibility 

11 Meatus acusticus externus sinister, craniolaterally Ortho Slice and Clip 

12 Dens caninus sinister (204), posterior buccal 
corner 

Junction from alveole to 
tooth 

13 Dens praemolaris 3 sinister (207), posterior 
buccal corner 

Junction from alveole to 
tooth 

14 Dens praemolaris 4 sinister (208) Junction from alveole to 
tooth 

   
15 Processus frontalis ossis zygomaticus dexter See left side 
16 Processus zygomaticus ossis frontalis dexter See left side 
17 Canalis opticus dexter, medioventrally See left side 
18 Meatus acusticus externus dexter, craniolaterally See left side 

19 Dens caninus dexter (104), posterior buccal 
corner See left side 

20 Dens praemolaris 3 dexter (107), posterior buccal 
corner See left side 

21 Dens praemolaris 4 sinister (108) See left side 
   
22 Processus mastoideus sinister Caudolateral view 
23 Processus mastoideus dexter Caudolateral view 
24 Processus paracondylaris sinister Ventral view 
25 Processus paracondylaris dexter Ventral view 

26 Tuberculum nuchale sinsiter Landmark set on the CT 
image; caudal view 

27 Tuberculum nuchale dexter Landmark set on the CT 
image; caudal view 

28 Condylus occipitalis sinister Landmark set on the CT 
image; caudal view 

29 Condylus occipitalis dexter Landmark set on the CT 
image; caudal view 

   
30 Basion Ortho Slice and Clip 
31 Os palatinum, most caudal point Caudoventral view 
32 Hamulus pterigoidei sinister Caudoventral view 
33 Hamulus pterigoidei dexter Caudoventral view 
34 Prosthion Rostral view 
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Figure 68: Amira set landmarks 

 

3.4. Save the landmark file as “petname_morphometric_landmarks_landmarkAscii” 
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4 Cranial index: 

4.1. Create a Scalebar with a Grid. Make sure the 3D view is set to orthographic 

and view an Isosurface of the CT scan. Then align the landmarks you want to measure 

with the grid by zooming in and out, read the units showed on the axes of the grid (1 

unit = 1mm) and write them down in a Microsoft Excel file.  

4.2.  

Figure 69: Amira cranial index 
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Figure 70: Amira Arcus width 

 

Figure 71: Amira units 
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4.3. These are the measurements:  

Table 54: Amira measurements 

 

 

5 Registering CT and MRI files: 

5.1. Open the already aligned CT file and the MRI file and visualize both with a Volren. For 

the CT Volren, let the “Transfer function” set to “VolrenRed” and set the MRI Volren to 

“VolrenGreen”. You can change the transparency for both with the brackets. 

 

Figure 72: Amira Volren colour 

 

Figure 73: Amira Volren colour green 

Cranial index Landmarks Info 
Facial length Nasion to Prosthion  dorsal view 
Facial width Widest interzygomatic distance  dorsal view 
Cranial length Inion to Nasion  dorsal view 
Cranial width Widest interparietal distance  dorsal view 
Cranial height Middle of Meatus acusticus externus to bregma lateral view 
Skull length Inion to Prosthion  dorsal view 
Skull base length Basion to Prosthion  ventral view 
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5.2. Enable the Transform Editor of the MRI file and roughly align it to the already 

orientated CT file. 

 

Figure 74: Amira scan alignment 
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Figure 75: Amira scans aligned 

5.3. Right click onto the MRI file → Geometry Transforms → Register Images 

 

Figure 76: Amira register images 
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5.4. Select the “Register Images” tool  and link the “Reference” to the CT file. 

 

Figure 77: Amira references link 

5.5. Now click “Apply” and wait until the rendering is finished. 

 

Figure 78: Amira references linked 



102 

 

5.6. To inspect the alignment, disable the Volrens of the CT and the MRI file, create an 

“Orthoslice” for the MRI file and then right click the Ortho Slice → Display → Colour 

Wash 

Figure 79: Amira colour wash 

5.7. Set the Data of the “Colour Wash” as the CT file. 

5.8. Disable the Transform Editor on the MRI file and with help of the Ortho Slice, check 

whether the Orientation of both files is appropriate based on the match of the skull and 

brain contour. 

 

Figure 80: Amira colour wash check 

5.9. Save the MRI file. 
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6 Segmentation of the brain: 

6.1. The now orientated MRI file is opened.  

6.2. Then right click on it → Image Segmentation → Edit New Label Field 

 

Figure 81: Amira new label field 

6.3. The program then switches automatically to the “Segmentation” Tab. 

 

Figure 82: Amira segmentation 
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6.4. Change the view to “XY” and select the material “Inside”. 

 

Figure 83: Amira inside material 

6.5. Use the “Threshold” tool and set the lower threshold to 150. 

 

Figure 84: Amira material threshold 
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6.6. “Select Masked Voxels” → “+” to add the selection to the material “Inside” 

 

Figure 85: Amira masked voxels 

6.7. Set a lower threshold of -114 and an upper threshold of 175 to select the “background” 

 

Figure 86: Amira threshold background 
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6.8. Now “Select Masked Voxels”, then “Grow Selection” three times and then “Shrink 

Selection” three times again to refine the borders. Remove this selection from the 

Inside Material by clicking the “-“ 

 

Figure 87: Amira grow selection 

 

Figure 88: Amira shrink selection 
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Figure 89: Amira remove selected 

6.9. To check the selection, use the “Pick and Move” tool and click into the brain. If only 

the brain turns red, the brain is extracted. If any surrounding tissue turns red too, there 

still are connections between the brain and the tissue. 

 

Figure 90: Amira segmentation pick 
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6.10. To remove these connections, “clear” the current selection and then use the 

“Brush” tool to select and then “-“ to remove them from the Inside material. Make sure 

all connections are removed by switching between the different views (XZ, XY, YZ) 

and scrolling through them.  

 

Figure 91: Amira clear selection 

 

Figure 92: Amira selection brush 

 

Figure 93: Amira "bridges" 
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6.11. If only the brain turns red when you click on it, all connections are removed. 

 

Figure 94: Amira correct selection 

6.12. Now invert the selection and remove the background by “Menu Selection” → 

Invert → All Slices 

 

Figure 95: Amira Invert selection 
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6.13. Now everything except the brain should turn red. Remove (“-“) the background. 

 

Figure 96: Amira inverted selection 

6.14. The violet border should now surround only the brain tissue. 

 

Figure 97: Amira selection border 
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6.15. To remove any holes, select the brain → Grow Selection four times → Shrink 

Selection four times and then add (“+”)  

 

Figure 98: Amira grow and shrink 

6.16. Additionally, go into the menu “Segmentation” → Fill holes → All Slices and 

afterwards check the brain in all axes if there still are any holes. 

 

Figure 99: Amira fill holes 
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6.17. The brain will be extended by one Voxel (Grow Selection) and then added (“+”) 

to the Inside Material 

 

Figure 100: Amira grow selection 

6.18. Switch into the “Project” tab and save the labels as 

“petname_MRI_Info_labels.am” 

 

7 Extraction of the brain and improving the resolution: 

7.1. Right click the MRI file → Compute → Arithmetic 

 

Figure 101: Amira arithmetic 
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7.2. Right click the white box next to “Arithmetic” and set the “Input B” as the new label file 

(“petname_MRI_Info_labels.am”) 

 

 

Figure 102: Amira arithmetic input 
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7.3. Left lick on the Arithmetic tool and in its properties, set the “Expression” to “(b==1)*a” 

(without the quotation marks) and hit “Apply” 

 

Figure 103: Amira arithmetic expression 

7.4. The newly generated “Result” contains only the brain and can be visualized by a 

Volren tool 

 

Figure 104: Amira result 
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7.5. Select the “Result” and enable the “Crop Editor” to then crop the box as close as 

possible to the brain without touching it by moving the green boxes → click OK when 

finished 

 

Figure 105: Amira crop editor 

 

Figure 106: Amira brain crop 

7.6. Right click the Result → Compute → Volume Operations → Resample 

 

Figure 107: Amira resample 
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7.7. In the properties of this “Resample” tool, check the “voxel size” box and set all three 

Voxel Sizes (x, y, and z) to “0.2” → Apply 

 

Figure 108: Amira resample settings 

7.8. The newly generated “Result.resampled” will be saved as 

“petname_MRI_Info_brain_resampled.am” 

7.9. The “Result” will be saved as “petname_MRI_Info_brain.am” 
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8 Generating the brain surface: 

8.1. Add a new Labelfield (see 6.2) to the “petname_MRI_Info_brain_resampled.am” 

8.2. Use the Threshold tool and set the lower value to resemble the edges of the brain → 

Select Masked Voxels → “+” 

 

Figure 109: Amira low brain threshold 

 

Figure 110: Amira add masked voxels 



118 

 

8.3. Fill the Holes in the menu Segmentation → Fill holes → All slices 

 

Figure 111: Amira fill holes 

8.4. Now soften the brain contour by clicking the menu Segmentation → Smooth labels → 

Size = 9, Mode = 3D Volume → Apply three times 

 

Figure 112: Amira smooth labels 
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8.5. Switch back to the Project tab and save the labelfile as 

“petname_MRI_Info_brain_resampled.label_brain-contour.am” 

8.6. Generate the brain surface by right clicking the new Labelfield → Generate Surface → 

Apply 

 

Figure 113: Amira generate surface 

8.7. Select the newly generated surface file and reduce the number of triangles by using 

the “Simplification Editor” → Faces = 300 000 → Simplify Now 

 

Figure 114: Amira simplification editor 
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8.8. To check the surface, right click it and choose “Surface View” 

 

Figure 115: Amira surface view 

8.9. This surface will be saved as “petname_brain.surf”. It is important to use the file format 

“HxSurface binary” (*.surf)! 

 

Figure 116: Amira binary 

9 Measuring the surface and gyri: 

9.1. Open the surface file “petname_brain.surf” and 

“petname_MRI_Info_brain_resampled.am” and visualize the surface with a Surface 

View (see 8.8) and the resampled file with a Volren. Hide the Volren by unchecking 

the orange box next to it and then select the surface to enable the “Surface Editor”. 

 

Figure 117: Amira surface editor 
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9.2. The view automatically switches to “outlined” and the triangles are visible. Use the 

“Draw contour to highlight faces” tool and uncheck the “Visible triangles only” function. 

 

Figure 118: Amira visible triangles 

9.3. Set the Surface Draw Style in the properties to “shaded” and then set the view so you 

see the brain from dorsally.  

 

Figure 119: Amira draw style 

9.4. Now choose the “Interact” tool and by left clicking and drawing the cursor, you can 

make a selection on the surface. The first selection should be the right half of the brain, 

but the selection should be slightly paramedian to the right. Check the selection by 

viewing the brain from every side and once it is okay, click the menu “Surface” → Edit 

→ Delete Highlighted Faces to delete the red triangles from the surface file. 

 

Figure 120: Amira interact tool 
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Figure 121: Amira paramedian brain 

 

Figure 122: Amira delete highlighted faces 

 

Figure 123: Amira brain half 
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9.5. Close the Surface Editor and save the file as “petname_brain_left.surf” (file format = 

“HxSurface binary” (*.surf)) 

9.6. Open the original “petname_brain.surf” again and repeat these steps but now with the 

left side to then save the file as “petname_brain_right.surf” 

9.7. Open “petname_brain.surf” again, enable the Surface Editor → Draw contour to 

highlight faces” but leave the “visible triangles only” checked. 

 

Figure 124: Amira surface editor 

 

Figure 125: Amira visible triangles 
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9.8. Set the Surface Draw Style to “shaded” → Interact tool → select the Cortex by turning 

the brain. It is recommended to now show the Volren file for better visibility of the 

borders of the Cortex. 

9.9. Once the Cortex of one brain half is selected, use the menu Surface → Edit → Set 

Boundary IDs  

 

Figure 126: Amira boundary ids 

9.10. Then click New → set the Material name in Info and a colour → OK → select 

new Boundary ID in the list → Set 

 

Figure 127: Amira boundary id settings 
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Figure 128: Amira clear buffer 

9.11. In the “Surface View”, change the “Colours” to “boundary ids”. 

 

Figure 129: Amira draw style boundary 

9.12. Now repeat the same steps to select the right Cortex and set its boundary id. 

 

Figure 130: Amira boundary id 2 
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9.13. Close the Surface Editor and save the file as “petname_brain_cortex-

measurements.surf” 

9.14. Right Click the surface → Measure and Analyze  → Surface Area Volume 

 

Figure 131: Amira surface area volume 

9.15. In properties, set the mode to “patches” and click Apply 

 

Figure 132: Amira patches 
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9.16. A new table will be generated → Click “show” and now read the table. Patch 1 

is the area that was not selected, Patch 2 the left Cortex and Patch 3 the right Cortex 

 

Figure 133: Amira show surface area 

 

9.17. To draw the Gyri, open “petname_brain_left.surf” and 

“petname_MRI_Info_brain_resampled.am”. Generate a Volren for the latter. 

 

Figure 134: Amira resampled Volren 
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9.18. For the file “petname_brain_left.surf”, the Surface Editor will be opened. 

9.19. Set the Draw Style in the Surface View to  “shaded” and in “more options” the 

function “Back Face” needs to be selected. The Surface disappears behind the Volren. 

 

Figure 135: Amira back faces 

9.20. Now the Gyri need to be drawn in a specific order using the “Draw contour to 

highlight faces” tool and enable “visible triangles only”.  

 

Figure 136: Amira visible triangles 
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Figure 137: Amira draw Gyrus 

 

9.21. To check the selection on the Surface, change the “Draw Style” to “Both faces” 

again. Always check if other areas of the surface are selected as well (turn the brain 

around) 

 

Figure 138: Amira both faces 
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9.22. If the selection is correct, set the boundary ID, its colour and name. 

 

Figure 139: Amira set boundary id 

 

Figure 140: Amira boundary id settings 

9.23. “Clear highlights or buffer” 

 

Figure 141: Amira clear highlights 
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9.24. Change the “Colours” of the surface view to “boundary ids” 

 

Figure 142: Amira surface view colour 

 

Figure 143: Amira coloured Gyrus 
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9.25. Draw the next Gyrus (repeat steps 9.20 to 9.23) and after setting the view to 

“both faces” always make sure there is no overlap between these Gyri (delete them 

with ctrl + left mouse button) 

 

Figure 144: Amira Gyri overlap 

9.26. The surface should look like this after setting the second boundary id/Gyrus 

 

Figure 145: Amira Gyri drawn 
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9.27. Once all Gyri are added to the surface, save the surface as 

“petname_brain_left_gyri.surf” (“HxSurface binary”) 

9.28. The Gyri can be checked in the Surface Editor by using the “Selector tool” and 

setting it to “boundary ids” 

 

Figure 146: Amira selector tool 

9.29. Also set the selector tool to “patches” and make sure the number of patches is 

the same as the number of boundary ids 
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Figure 147: Amira patch selector 

9.30. Measure the Gyri Area by right clicking the surface file → Measure and Analyze 

→ Surface Area Volume 

 

Figure 148: Amira surface area volume 

9.31. Set the properties to “patches” and hit Apply 

 

Figure 149: Amira patches apply 
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9.32. A new table will be generated and saved under the suggested name 

(petname_brain_left_gyri.statistics.am). Then “show” the table and read the values of 

each patch in mm2. The number of the patch resembles the number of the boundary 

id + 1. So, boundary ID 0 should be Patch 1 in the table.  

 

Figure 150: Amira show surface area 
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9.33. Always use the Selector tool (set to patches) to check if the patch and boundary 

id match. 

 

Figure 151: Amira patch selector 

9.34. Repeat steps 9.17 to 9.33 for the right half of the brain 
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10  Generating the skull model and measuring the craniotomy area 

10.1. Generate an Isosurface of the CT scans (see 2.2) with a Threshold of 350 

10.2. In its properties → more options → Create Surface 

 

Figure 152: Amira create surface 

10.3. The newly generated Surface is saved as “petname_CT_skull.surf” 

10.4. Delete the Isosurface and generate a Surface View (see 2.2) and change the 

Draw Style → more options → Direct normals 

 

Figure 153: Amira direct normals 
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10.5. Right click into the Project space and create a new object → Points and Lines 

→ Landmarks 

 

Figure 154: Amira landmarks 

10.6. Now set the landmarks (see 3) for the drill-holes/burr-holes). You can use the 

“Measure” tool to measure distances (unit is mm) 

 

Figure 155: Amira measure tool 
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10.7. Save the landmarks as “petname_CT_drillholes_approach.landmark.Ascii” 

10.8. Change the landmark size in the properties of the Landmark view to 0.5 

 

Figure 156: Amira landmark size 

10.9. Enter the Surface Editor of the “petname_CT_skull.surf” 

 

Figure 157: Amira surface editor 



140 

 

 

Figure 158: Amira draw contour 

10.10. Use the “Draw contour to highlight faces” tool and enable “visible triangles only” 

 

Figure 159: Amira visible triangles 
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10.11. Use the “Interact” tool to draw the selection whilst holding down the left mouse 

button. (delete with ctrl + left mouse button) 

 

Figure 160: Amira draw craniotomy 

10.12. Check the selection by rotating the whole skull 

10.13. When the selection is complete, set a new boundary id 

 

Figure 161: Amira set boundary ids 



142 

 

 

Figure 162: Amira boundary id settings 

10.14. Save the surface under “petname_CT_skull_craniotomy_approach.surf” 

10.15. Measure the surface area by right clicking the surface →Measure and Analyze 

→Surface Area Volume 

 

Figure 163: Amira surface area volume 
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10.16. Properties → Patches →Apply →Show 

 

Figure 164: Amira patches apply 

10.17. In the Surface View, change the “colours” to “boundary ids” 

 

Figure 165: Amira colours bondary id 
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11  Simulating the Craniotomy 

11.1. Load the surface “petname_CT_skull.surf” and the landmark file 

“petname_CT_drillholes_approach.landmark.Ascii” and set the landmark size to 0.5 

 

Figure 166: Amira simulate craniotomy 

11.2. Open the Surface Editor and disable “visible triangles only” 

 

Figure 167: Amira visible triangles 
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11.3. Draw a contour around the landmarks 

#  

Figure 168: Amira draw contour 

11.4. Because the “visible triangles only” was disabled, underlying material and the 

opposite side are selected as well. Make sure to delete (ctrl + left mouse button) the 

unwanted triangles. 

 

Figure 169: Amira draw error 
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Figure 170: Amira correct drawing 

11.5. When the selection is complete, go to “Surface”→ Edit → “Delete highlighted 

faces”  

 

Figure 171: Amira delete faces 
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11.6. Save the surface as 

“petname_CT_skull_craniotomy_window_approach_left.surf” 

11.7. Repeat steps 11 to 11.5 for the right side if necessary 

11.8. When a MR file is loaded, it should look like follows 

 

Figure 172: Amira craniotomy completed 
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12 Measuring the Gyri area  

12.1. Load the “petname_CT_skull_craniotomy_window_approach_left.surf” and 

“petname_brain_left_gyri.surf” 

12.2. Set the Surface View of the brain/gyri to “boundary ids” which should then look 

like follows (example, anatomy not correct) 

 

Figure 173: Amira craniotomy with brain 
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12.3. Open the Surface Editor for “petname_brain_left_gyri.surf” and choose the 

“Draw contour to highlight faces” tool with enabled “visible triangles only” to then draw 

the accessible brain are through the craniotomy window. 

 

Figure 174: Amira draw craniotomy window 

12.4. Disable the Surface view of the 

“petname_CT_skull_craniotomy_window_approach_left.surf” to check the selection 

(rotating the whole brain) 

 

Figure 175: Amira craniotomy window on brain 
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12.5. Set a new boundary id for the selection 

 

Figure 176: Amira boundary id 

12.6. Save the file as “petname_brain_left_gyri_window.surf” 

12.7. Measure the areas by right clicking the surface file → Measure and Analyze 

→Surface Area Volume. Set the properties to “patches” → Apply   

12.8. Save the file under the suggested name and then click “show” 

12.9. The newly generated table (unit=mm) displays the area for each patch (Patch 

number in the table = Patch number in the Viewer +1) 
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Figure 177: Amira Gyrus area 

12.10. Write down the “Area” (right most row in the table) into a Microsoft Excel file (or 

similar programs) 

12.11. Use these values for further calculations 

3 
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13 Sinus frontalis 

13.1. Load the “petname_CT_skull_craniotomy_window_approach_left.surf” and the 

already aligned CT stack. 

13.2. Load an Ortho Slice tool on the CT stack, choose the right plane so the Ortho 

Slice is a transverse slice and navigate it one slice rostrally to the craniotomy. 

 

Figure 178: Amira craniotomy both sides 
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13.3. Now look at the CT scan from the front to see if a Sinus frontalis is visible or not. 

It cannot be opened if there is no Sinus frontalis visible. Check for any interference of 

craniotomy and the Sinus frontales if it is visible. 

13.4.  

Figure 179: Amira Sinus frontalis not opened 

13.5.  

Figure 180: Amira check for interference 

13.6. Write down the gathered information 
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